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In this Guide … 
This guide describes the requirements, installation, configuration and maintenance 
of the Sample Scheduler for OpenLab software version 2.7.  

In addition, it contains information on LIMS commands, XML structures, and 
troubleshooting hints. 

Sample Scheduler for OpenLab was designed to work with two Agilent 
Chromatography Data Systems: OpenLab CDS and EZChrom. Some features or 
behaviors of the Sample Scheduler software differ depending on your CDS. This 
document includes details on these differences. 

Table 1 Terms and abbreviations 

Term Description 

CDS Chromatography Data System 

Content Management Data storage component provided as part of the OpenLab system 

EZChrom OpenLab CDS EZChrom Edition and OpenLab EZChrom 

Control Panel Control Panel for Agilent OpenLab software 

Microsoft Control Panel Part of the Microsoft Windows operating system 

AIC Agilent’s Analytical Instrument Controller 

 



Contents 

4  Sample Scheduler for OpenLab  

Contents 
1 Architecture 10 

2 Requirements 13 

Software Requirements 13 

Operating Systems 13 

.NET Framework 13 

Supported Browsers 13 

Language Compatibility 14 

Computer Date/Time 14 

Databases 14 

OpenLab CDS and EZChrom Supported Configurations 15 

SLIMS Compatibility 15 

Network Requirements 16 

Firewall Settings 16 

Hardware 16 

PC Graphics Display Resolution 16 

Required Resolution to Access the Sample Scheduler Web Interface 17 

Disk Space 17 

RAM Requirements 17 

Number of Instruments 18 

Other Requirements 19 

Considerations in a Regulated Environment 19 

3 Licensing 20 

4 Installation 21 

Control Panel Configuration 21 



Contents 

Sample Scheduler for OpenLab 5 

Sample Scheduler Deployment 22 

Supported Deployments 25 

Sample Scheduler Installation Instructions 28 

Install Sample Scheduler 28 

Silent Installation 39 

Software Verification Check 43 

Automatic Generation of Installer Logs 43 

In a Regulated Environment: Create a Service User in OpenLab 43 

In a Regulated Environment: Restrict Access to LIMS Result Folder 45 

Activate Sample Scheduler 45 

5 Post Installation Tasks 47 

Configure Antivirus Program 47 

Start Services 48 

Start LIMS Agent Service 48 

Start Sample Scheduler Agent 48 

Configure LIMS Transfer 49 

Install a Trusted SSL Certificate 49 

Install an SSL Certificate in the Windows Keystore 50 

Assign Trusted SSL Certificate to the Sample Scheduler Webserver 51 

Disable Legacy SSL Versions 52 

Use Sample Scheduler Lab Balance Bridge 52 

6 Configuration of Specific Sample Scheduler Settings 53 

User Privileges 53 

Audit Trail 56 

Enable Audit Trail 56 

Audit Trail Settings 56 



Contents 

6  Sample Scheduler for OpenLab  

Enable Single Sign-On 58 

7 Upgrade 59 

Upgrade with CDS Master Installer 60 

8 Migration 61 

Migration Tools for Moving from EZChrom to OpenLab CDS 61 

EZChrom to OpenLab CDS with Sample Scheduler 62 

Additional Information 62 

Data Migration Utility for Upgrading the Sample Scheduler Database 63 

Registration Tool 64 

Run the Data Migration Utility 64 

9 Uninstallation 67 

Uninstall Plugin in the CDS OpenLab Acquisition 68 

10 LIMS Command: Analysis Order generated by the LIMS 69 

XML Commands 70 

Encoding 70 

High Level XML Command Structure 71 

Restart an Analysis from the LIMS 72 

Basic XML Command 73 

Advanced XML Command 75 

Multiple LIMS Connections 82 

Dual Simultaneous Injection with XML Commands 83 

Using Parameter ‘Use Method Injection Volume’ in XML Command 83 

Instrument Groups with XML Commands 84 

Add Multiple Instrument Lines to a Group 85 

Analysis Variables in the XML Command 85 



Contents 

Sample Scheduler for OpenLab 7 

Sample Custom Parameters in the XML Command 86 

Use Tokens in the XML Command 86 

Priority Rules 88 

XML Command Creation 90 

XML Action 91 

Sample Scheduler XML File Generator 93 

Command Collected via SQL Query 94 

Configure the Connection String 95 

Write an SQL Query 96 

SQL Query Examples 101 

SQL Query 104 

LIMS Notification 105 

Dual Simultaneous Injection via SQL Query 106 

Sequence Creation via SQL Query 106 

11 Command Validity Process 107 

12 Activity Logs 111 

13 Maintenance Operations 112 

Reconfigure Sample Scheduler Database 112 

Change the Sample Scheduler Agent assigned to an Instrument 113 

Rename a Computer that is the Host of a Sample Scheduler Agent 114 

Rename the Instrument in the Control Panel 115 

Add an Instrument in the Control Panel 115 

Delete an Instrument in the Control Panel 116 

Deploy a Reconfigured Instrument in Sample Scheduler 116 

Change Project Settings in the Control Panel 116 



Contents 

8  Sample Scheduler for OpenLab  

Adding an AIC after Activation 117 

Uninstall/Update Sample Scheduler for OpenLab 117 

Connect to Another Server 117 

Change Authentication Mode 118 

Back up the Sample Scheduler database 119 

Recovery models 120 

Backup Procedure 121 

Restore in case of failure 121 

Appendix A: Microsoft SQL Server Configuration 122 

Configure SQL Protocol for Remote Access 122 

Switch SQL Server Authentication Mode 126 

Edit or Add System Administrator 128 

Setting Up SQL Server Accounts other than ‘sa’ 131 

Create the User/Group that should be used by Sample Scheduler 131 

Give Execute Permission to the New User/Group 134 

Give User the Right to Execute Stored Procedure 135 

Configure Firewall for SQL Server 136 

Testing Sample Scheduler Database Connectivity 137 

Check Database Connectivity 137 

14 Appendix B: Sample Scheduler for OpenLab Lab Balance Bridge 145 

Compatibility 145 

Requirements 145 

Configuration 146 

Optional OpenLab Configuration 147 

LabX Task Result Mapping 148 

Mapped Method Function Names 148 



Contents 

Sample Scheduler for OpenLab 9 

Appendix C: Troubleshooting 150 

Core Engine Service does not Start 151 

Both Sample Scheduler Services do not Start 151 

Sample Scheduler Agent Service does not Start 151 

XML Command Management 152 

Command File got Stuck in the LIMS_Commands Folder 152 

Command File is not Archived in the Processed Folder 152 

Command is Rejected in the Trash Folder 152 

Command collected in LIMS from SQL Query 153 

LIMS Database not notified back 153 

Analysis got Stuck During Life Cycle 155 

Analysis Stays in Scheduled State 155 

Analysis Stays in Submitted State 155 

Analysis Blocked in the Sample Scheduler database 155 

Analysis Turns into Error/Waiting on Error 156 

Analysis Turns into Error after Having been Stopped from the CDS 156 

Analysis Passes from Scheduled to Error or Waiting on Error State 156 

Client or Configuration Connection Issues 156 

Analyses are not Displayed in the Sample Scheduler Client 157 

Loss of Connection 157 

Critical Error when Saving Configuration 157 

Impossible to Start Sample Scheduler Services 158 

Scalable System Shows Multiple Main Instances 158 

Dashboard does not Open After Reinstallation With new Database 159 

Appendix D: Parameter Mapping to CDS 160 

 



Architecture 

10  Sample Scheduler for OpenLab  
 

1 Architecture 

Sample Scheduler for OpenLab is an application intended to improve the 
productivity of chromatographic analysis in the laboratory by fully automating the 
analysis. 

Sample Scheduler is a powerful interface between any front-end platform like a 
Laboratory Information Management System (LIMS) that sends analysis orders, 
and the OpenLab Chromatography Data System (CDS) solution that performs and 
processes the analysis. 

Sample Scheduler for OpenLab supports two types of LIMS: 
 LIMS that are able to provide analysis orders via a structured XML file in a 

dedicated folder 
 LIMS that can provide the information required to create an analysis order, by 

answering a structured SQL query sent by the Sample Scheduler 

In both cases, when Sample Scheduler receives a LIMS command (that is an 
analysis order) in which the analysis status is set to Scheduled, it checks the 
command’s validity and the availability of the required chromatographic instrument. 
A user can review and complete the analysis parameter in Sample Scheduler before 
the acquisition or it can be automatically scheduled for acquisition if specified by 
the LIMS. Then, Sample Scheduler submits the analysis to the instrument queue in 
the CDS, where it is acquired as soon as the instrument is idle, and an instrument 
connection license is available. This way the samples are analyzed quickly, and the 
laboratory instrument use is optimized. 

Sample Scheduler for OpenLab is composed of: 
 a database (SQL Server or OpenLab Data Repository) 

This database is used to store the Sample Scheduler configuration parameters 
and all the analyses with their parameters and states. 

 one LIMS agent 
 one or several Scheduler agent(s) 
 a webserver 
 multiple instances of the user interfaces: Sample Scheduler configuration, 

Sample Scheduler client and web interfaces 
 the Database Management Agent 
 the Sample Scheduler Orchestrator 
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The LIMS agent: 
 scans the folder in which the LIMS generates the commands or periodically 

queries the LIMS thanks to a SQL query to recover analysis order, 
 checks the commands’ validity,  
 transforms valid commands into analyses stored in the database and sends 

invalid commands into a trash folder located in the LIMS_Commands folder 
root and, if enabled, notifies the administrator. 

 

Scheduler Agent: Several Scheduler agents can be installed (one per computer). The 
role of each Scheduler agent is to manage a pool of instruments.  

Each Scheduler agent … 
 requests the Sample Scheduler database to know if there is an analysis to 

handle on one of the instruments it manages, 
 requests the Chromatography Data System to check the instrument license 

availability and its status, 
 initiates an acquisition through a specific agent: the Scheduler acquisition agent 

(one per instrument). Then this specific agent will handle the acquisition, 
through the Chromatography Data System acquisition process, and updates 
the analysis state. 

 

The user interface of the Sample Scheduler for OpenLab Client … 
 lists all analyses stored in the database, 
 displays in real time the state of the analyses and available information, 
 allows the analyst to add/edit analyses, etc. 

 

The user interface of the Sample Scheduler for OpenLab Configuration allows the 
Sample Scheduler administrator to configure the Sample Scheduler (LIMS 
commands folder path, SQL queries, etc.). 

 

The Sample Scheduler web server and web interface …  
 allow users a controlled access to view, edit, and schedule analyses by simply 

using a web browser,  
 give managers an overview of the total analyses workload of the laboratory as 

well as the usage and status of all instruments,  
 give operators a simple overview of their daily workload of chromatographic 

analyses. 
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Figure 1 Sample Scheduler Architecture 
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2 Requirements 

Software Requirements 

Operating Systems 

Sample Scheduler client, Sample Scheduler configuration, and Sample Scheduler 
agent: 
 Win 10 64 bit Pro or Enterprise (version  1809 LTSC,  20H2, 21H2) 
 Windows 11 64 bit Pro or Enterprise 
 Windows Server 2012 R2 
 Windows Server 2016 
 Windows Server 2019 

Sample Scheduler LIMS agent and Sample Scheduler web interface: 
 Windows Server 2012 R2 
 Windows Server 2016 
 Windows Server 2019 

.NET Framework 

Sample Scheduler for OpenLab requires the .NET framework 4.7.2, ASP.NET Core, 
and .NET Core 3.1. The version for the .NET Core Runtime needs to be the same or 
higher as the version of the ASP.NET Core Runtime. 

 

NOTE For localized versions of Sample Scheduler for OpenLab, install the .NET framework 
language pack corresponding to the version of the .NET framework.  

 

Supported Browsers 

 Chrome: 99 
 Microsoft Edge 99  
 Safari iOS version 15 
 Safari Mac OS version 15 

The Sample Scheduler Web Interface user interface is responsive. Thus, the view 
shown in a web interface depends on the screen size of your device. 
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Language Compatibility 

The English version of Sample Scheduler for OpenLab is validated on Windows 
English. 

Localized versions of Sample Scheduler for OpenLab are supported on the 
following localized language versions of Windows: 
 Chinese 
 Japanese 

Sample Scheduler for OpenLab can run on other language versions of Windows as 
well, but the user interface will be English. 

The Sample Scheduler web interface is localized for the following browser 
languages: 
 Chinese 
 Japanese 

For other browser languages the web interface will be in English. 

Computer Date/Time 

All Sample Scheduler computers must be synchronous: same date/time. 

Databases 

Sample Scheduler for OpenLab can use one of the following databases: 
 OpenLab Data Repository 

OpenLab Data Repository (OLDR) is available as part of the OpenLab Platform, 
which is a component of OpenLab CDS 2.5 or higher. It is used to store 
diagnostic and topology related information but can also host a Sample 
Scheduler database. Note that OLDR is available only for OpenLab CDS 
configurations without EZChrom. 

 SQL Server 

The supported SQL Servers are: 
 SQL Server 2016 Express or Standard 
 SQL Server 2017 Express or Standard 
 SQL Server 2019 Express or Standard 

For more information about configuring the SQL Server, refer to “Appendix A: 
Microsoft SQL Server Configuration” on page 122. 
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If you use an SQL Server instance, a valid administrator name and password 
must be available prior to the Sample Scheduler installation. You will have to 
enter the name of the SQL Server computer, the name of the instance and the 
associated credentials during the Sample Scheduler installation. 

Installing SQL Server Management Studio can be useful if you need to set up 
database users. 

OpenLab CDS and EZChrom Supported Configurations  

Sample Scheduler for OpenLab is not supported on a Standalone Workstation. 
 

Sample Scheduler for OpenLab version 2.7 is compatible with: 
 OpenLab CDS 2.5 Client/Server System with a content management system 
 OpenLab CDS 2.6 Client/Server System with a content management system 

 OpenLab CDS 2.7 Client/Server System with a content management system 
 OpenLab CDS EZChrom Edition A.04.09 or OpenLab EZChrom A.04.10 

Distributed System with file system storage, Content Management, ECM XT, 
ECM 3.5 Update 6, or ECM 3.6 

 Mixed configurations using ECM XT or OpenLab Server are supported with 
OpenLab CDS versions 2.5 or 2.6 with OpenLab CDS EZChrom Edition A.04.09 
or OpenLab EZChrom A.04.10. 

In an environment regulated by 21 CFR Part 11 and Annex 11, Sample Scheduler for 
OpenLab is only supported in combination with OpenLab CDS 2.5 or higher. A 
configuration with EZChrom is not supported in a regulated environment. 

SLIMS Compatibility 

Sample Scheduler 2.7 is compatible with SLIMS 6.7 and 6.8. 
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Network Requirements 

Firewall Settings  

The following ports are used by default for the Sample Scheduler: 
 CDS versions older than 2.7: TCP port 52088 (https protocol, used to reach the 

Sample Scheduler web interface, used to remotely start/stop/restart services 
via the Sample Scheduler configuration) 

 CDS version 2.7 and newer: only TCP port 443 
 OLDR: port 5433 

They will automatically be opened if you install the Sample Scheduler web interface. 

In addition, exceptions for the ports used by Microsoft SQL Server needs to be 
added. For details, see “Configure Firewall for SQL Server” on page 136. 

Hardware 

PC Graphics Display Resolution 

The minimum screen resolution for OpenLab CDS is 1600 x 900 pixels (1920 x 1080 
is recommended). 

The minimum screen resolution for EZChrom is 17 '' 1280 x1024 pixels (SXGA) 
(19'' 1440 x 900 is recommended). 
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Required Resolution to Access the Sample Scheduler Web Interface 

For mobile devices the minimum display width is 360 pixels.  

You can only access the Sequence View with a tablet or desktop that supports a 
minimum display width of 1024 pixels. 

Disk Space 

The disk space required to install Sample Scheduler for OpenLab is about 220 Mb. 

RAM Requirements 

RAM requirements of Sample Scheduler depend on: 
 The role of the computer (Scheduler agent, LIMS agent, Sample Scheduler 

client), 
 The number of instruments, and 
 The number of analyses to store in Sample Scheduler database. 

Table 2 Roles and required RAM 

Role Physical memory (RAM) 

LIMS agent 120 MB 

Scheduler agent 
+ 
Scheduler Acquisition agent (multiply with 
no. of instruments managed by the 
Scheduler agent) 

150 MB 
+ 
150 MB multiplied with no. of instruments 

Scheduler client Depends on the number of analyses stored in Sample 
Scheduler database. 
5000 analyses: 500 MB 
20 000 analyses: 900 MB 

SQL Server/OLDR Depends on the number of analyses stored in Sample 
Scheduler database. SQL Server manages the memory 
usage in a nonlinear manner (not proportional to the 
number of entries in the database). Refer to SQL Server 
specifications to properly set the SQL Server sizing. 

Webserver approx. 150 MB. 
Depends among others on the number of analyses, 
Instruments, and users in the system 

Database Management Agent 50 MB 
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Example 

RAM required for a computer, where: 
 One OpenLab CDS client, one Scheduler agent managing 5 instruments and 

one Sample Scheduler client are installed. 
 About 5000 analyses are displayed in the Sample Scheduler user interface: 

The required RAM for Sample Scheduler is: 150MB plus 750MB (150MB multiplied 
by 5) plus 500 MB = 1.4 GB. 

The RAM of the computer must be equal to the OpenLab CDS required RAM plus 
about 2 GB for Sample Scheduler. 

 

NOTE It is advised to store no more than 20 000 analyses in the Sample Scheduler 
database. Excess of analyses might induce Sample Scheduler performance loss. 
Sample Scheduler client is not opened if there are more than 20 000 analyses in the 
database because the memory capacity of the 32-bit process is limited. 
To avoid the accumulation of Ended analyses in the Sample Scheduler database, 
you can configure the time until the Ended analyses are automatically removed 
from database. To learn more about the parameter Database command life time, 
refer to the System Configuration chapter of the Sample Scheduler online help 
(search for Command processing). 

 

Number of Instruments 

A maximum of 20 instruments can be managed per Scheduler agent. 
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Other Requirements 

Sample Scheduler for OpenLab is working with OpenLab CDS or OpenLab 
EZChrom. Thus, systems with Sample Scheduler installed must satisfy the 
corresponding Chromatography Data System requirements.  

Please refer to the OpenLab CDS Requirements guide (CDS_Requirements.pdf) or 
OpenLab EZChrom Requirements guide. 

For requirements of the server in an OpenLab System, please refer to the OpenLab 
Server and OpenLab ECM XT Hardware and Software Requirements guide 
(ECM_XT_HardwareSoftwareRequirements.pdf). 

Additional restrictions might apply depending on other software that is installed on 
the same machine, for example, SQL server. 

Considerations in a Regulated Environment 

In regulated environments, you must reduce user privileges to a minimum in order 
to protect the system. Therefore, a specific OpenLab CDS user account is required 
for a Service user: This is a user with the privileges required to run automated 
Sample Scheduler services in the background. For example, the service user 
schedules analyses that are provided by the LIMS. The service user must remain 
enabled if you use Sample Scheduler for OpenLab in your laboratory environment, 
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3 Licensing 

Every LIMS connection configured in the Sample Scheduler system requires a 
license. Each time the LIMS agent service starts, it checks the licensing server for 
an available license for each LIMS connection and uses it during its operation. If the 
LIMS agent is stopped or fails, the licenses are released again. 
 In addition, you also need a Sample Scheduler Expansion Pack license to use 

instruments. The number of connection licenses depends on the number of 
instruments you want to use at the same time. 

 You need to have a Sample Scheduler for OpenLab license for each LIMS. Add 
the license prior to the Sample Scheduler installation. 

To add a license: 

• In the Control Panel under Administration, select Licenses and click Add. 
Enter the license number. 

• After adding a Sample Scheduler for OpenLab license: Start the LIMS Agent 
service on the respective computer, and set its startup type to Automatic. 

 

NOTE Load the license onto the licensing server of the respective host. If there is no 
Sample Scheduler for OpenLab license on the specified licensing server, the LIMS 
agent cannot be started.  
Only as many LIMS connections are possible as licenses are available. If the 
number of LIMS connections exceeds the number of available licenses, the last 
connections in the list Selected LIMS (Sample Scheduler configuration > LIMS 
tab) are not established by Sample Scheduler. XML commands or actions 
addressed to a not established LIMS connection will not be executed and moved to 
the trash folder. 
The users defined in the Notification tab will be informed about the trashing of the 
XML and the reason for it (in this case, the missing license). The notification can 
happen by email and/or on the Notification tab of the Sample Scheduler client. For 
more information, refer to the System Configuration chapter of the Sample 
Scheduler online help (search for Notifications). 
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4 Installation 

Control Panel Configuration 

 Only the Internal or Windows Domain authentication modes are supported. 
 Projects are defined with a valid project folder path (where the CDS files are 

stored: methods, chromatograms, etc.).  
 One user, with the required privileges to activate Sample Scheduler for OpenLab 

must exist in the Control Panel. This user’s credentials will also be used by 
Sample Scheduler services (Agilent Sample Scheduler LIMS Agent and Agilent 
Sample Scheduler Agent) to run automated Sample Scheduler services in the 
background.  
In regulated environments, you will create a Service user for this purpose (see 
“In a Regulated Environment: Create a Service User” on page 43). 
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Sample Scheduler Deployment 

The Scheduler deployment is strongly linked to the settings in the OpenLab Control 
Panel.  

Please consider each of the following system components while deploying the 
application: 
 The server in the OpenLab system manages Shared Services, and, if applicable, 

Content Management. 
 The Analytical Instrument Controller (AIC) manages the communication 

between CDS and instruments. 
 The CDS Client Interface allows you to create methods, process analyses, 

perform analyses, etc. 
 The Sample Scheduler database (SQL Server instance or OpenLab Data 

Repository for use with Sample Scheduler for OpenLab) stores Sample 
Scheduler configuration parameters and analyses. 

 The Sample Scheduler LIMS agent monitors analysis requests generated by the 
LIMS. 

 The Sample Scheduler agent monitors instrument(s) activity and submits 
acquisitions to the CDS. A single Sample Scheduler agent can manage up to 
20 instruments, but it is strongly advised to distribute the instruments on 
several Sample Scheduler agents. 
Sample Scheduler agent can be installed on CDS Clients or CDS Analytical 
Instrument Controllers (AICs). 
The Sample Scheduler Agent service must be started on a user account with 
administrative privileges for actions related to machine configuration or 
certificate installation. 

 The Sample Scheduler Orchestrator is a new service. This service handles the 
communication between Sample Scheduler Agent and Acquisition Agent on the 
AIC with the Sample Scheduler database. 

It is installed together with the Scheduler Webserver feature as a Windows 
Service. 

The service is disabled before activation. When activating Scheduler, the 
startup type is set to Automatic before enabling the Scheduler Agents. 
Uninstalling the Scheduler removes this service. 

 The Sample Scheduler client provides an interface that displays all the analyses 
to perform. 
Sample Scheduler client can be installed on CDS Clients or Analytical 
Instrument Controllers (AICs). 
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 The Scheduler Database parameter for database access has to meet the 
database access requirements for all distributed Sample Scheduler 
components which need to access the database. It is not sufficient to meet the 
needs of the local services which are checked during the installation. Otherwise 
services on other computers may not be able to start after installation. 

 The database access parameters can be adjusted after installation with the 
Database Access Reconfiguration Tool 
Agilent.Scheduler.Database.Access.Reconfiguration.exe, available from the 
\bin folder of the Sample Scheduler installation directory located only on the 
Shared Services server (default path: C:\Program Files (x86)\Agilent 
Technologies\Sample Scheduler for OpenLab\Bin). 

 

Some roles can co-exist on a single machine, some others are mutually exclusive. 
The following rules must be respected: 
 Only one Sample Scheduler database, and one Sample Scheduler LIMS agent 

can be installed for the entire application. 
Scheduler webserver can be installed on any server with the necessary CDS 
components. 

 The Sample Scheduler database may run on the server of the OpenLab system 
(optional with SQL Server, always with OpenLab Data Repository). If it runs on 
the server, make sure that the server is powerful enough (RAM and CPU must 
consider both OpenLab system requirements and Sample Scheduler 
requirements). If you use an SQL Server instance and your activity is intense, 
you might need to install it separately.  

 The Sample Scheduler LIMS agent should be installed on the server operating 
system. It can be installed on a CDS Client computer if the Client is installed on 
a server operating system.  
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 Sample Scheduler agent:  
 Several Sample Scheduler agents can be installed only once per computer. 
 Sample Scheduler agent should be installed on an AIC. Using OpenLab 

CDS, a Sample Scheduler agent is already pre-installed on AICs. 
 

OpenLab CDS installs the following Sample Scheduler agent versions: 

Table 3 Pre-installed Sample Scheduler agent versions 

OpenLab CDS version Sample Scheduler agent version 

OpenLab CDS 2.3 SampleScheduler agent 2.1 

OpenLab CDS 2.4 SampleScheduler agent 2.2 

OpenLab CDS 2.5 SampleScheduler agent 2.4 

OpenLab CDS 2.6 Sample Scheduler agent 2.6 

OpenLab CDS 2.7 Sample Scheduler agent 2.7 

 The target folder for the LIMS-generated XML commands:  

The folder "LIMS_Commands" can be defined on any computer, with or without 
OpenLab CDS, EZChrom, or Sample Scheduler for OpenLab installed. If it is not 
on the CDS machine, the LIMS_Commands folder must be shared over the 
network. The LIMS agent service must be started on a user account that has 
full access (write, read, delete, create) to this Share. 
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Supported Deployments 

Table 4 Minimal deployment 

Computer Scheduler 
database 

Scheduler 
database 
Management 
agent 

Scheduler LIMS 
agent 

Scheduler agent Scheduler client Scheduler 
webserver  

C1 (Server)       - -   

C2 (AIC) - - -   - - 

C3 (CDS 
Client) 

- - - -   - 

 

Table 5 Advanced deployments with several Sample Scheduler agents 

Computer Scheduler 
database 

Scheduler 
database 
Management 
agent 

Scheduler LIMS 
agent 

Scheduler agent Scheduler client Scheduler 
webserver 

C1 (Server)       - -   

C2* (AIC) - - - - - - 

C3* (CDS 
Client) 

- - - -   - 

C4* (AIC) - - -   - - 

* Several computers can be installed with this configuration 
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According to this exemplary deployment: 
 LIMS agent can be installed on every computer on which a CDS is installed. 
 If you use an SQL Server instance, the Sample Scheduler database can be 

installed on a separate machine. This separate machine does not need a CDS 
installation. 

 

Table 6 Advanced deployments with multiple servers 
    

Computer Shared 
Services 
Server 

Database 
Server 

Scheduler 
Server 

CDS 
Client 

AIC Scheduler 
database 

Scheduler 
LIMS 
agent 

Scheduler 
agent 

Scheduler 
webserver 

Scheduler 
client 

C1   - - - -   - -   - 

C2 -   - - - - - - - - 

C3 - -   - - -   - - - 

C4 - - - -   - -   - - 

C5* - - -   - - - - -   

* Several computers can be installed with this configuration 

 

Another deployment option is to install one Sample Scheduler agent per AIC, and to 
configure the application such that the Sample Scheduler agent manages the same 
instruments as the AIC. This approach can make maintenance more intuitive, since 
both CDS acquisition services and Sample Scheduler services are located on the 
same computer. If the computer has to be switched off for maintenance purpose, 
this ensures that both CDS and Sample Scheduler are switched off properly. 

Table 7 Advanced deployments with one Sample Scheduler Agent 

Computer Scheduler 
database 

Scheduler 
database 
Management 
agent 

Scheduler LIMS 
agent 

Scheduler agent Scheduler client  
Scheduler 
webserver 

C1 (Server)     - - -   

C2* (AIC) - - -   - - 

C3* (CDS 
Client) 

- -   -   - 

C4* (CDS 
Client) 

- - - -   - 

* Several computers can be installed with this configuration 
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According to this exemplary deployment: 
 LIMS agent can be installed on every computer on which a CDS is installed. 
 If you use an SQL Server instance, the Sample Scheduler database can be 

installed on a separate machine. This separate machine does not need a CDS 
installation. 
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Sample Scheduler Installation Instructions 

Install Sample Scheduler 
 

NOTE If you install OpenLab CDS 2.7, or upgrade OpenLab CDS to version 2.7, Sample 
Scheduler for OpenLab is installed automatically. You only need to activate it (see 
“Activate Sample Scheduler” on page 45). You only need the following instructions if 
you use a CDS system lower than 2.6, or if you install or upgrade individual Sample 
Scheduler modules on dedicated machines. 

 

Prerequisites:  
 The computer matches the requirements described in the “Requirements” 

section on page 13. 
 The Control Panel configuration matches the requirements described in the 

“Control Panel Configuration” section on page 19. 
 The Sample Scheduler configuration is defined according to the “Sample 

Scheduler Deployment” section on page 22. 
1 Download the Agilent.Scheduler.Install_XX.msi file from SubscribeNet (XX 

stands for the language code). 

Important: The first Sample Scheduler installation must be done on the Shared 
Services server. 

2 Click Next on the Welcome page. 

  
   Figure 2 Welcome page 
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3 Read the License Agreement and accept it. Click Next to continue the 

installation. 

  
   Figure 3 License Agreement 

4 On the Custom Setup page, select the application module(s) to be installed 
among the list, according to the desired configuration: 
 Sample Scheduler agent 
 Sample Scheduler LIMS agent (installed only on one computer) 
 Scheduler Database 
 Sample Scheduler client 
 Sample Scheduler web interface  

   
   Figure 4 Custom Setup page 
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5 For each module you can choose to install the feature (select either Will be 
installed on local hard drive or Entire feature will be installed on local hard 
drive, both lead to the same result), or to not install it by choosing Entire 
feature will be unavailable. 

   
   Figure 5 Install features 

 Install Sample Scheduler agent on a computer that will manage 
instruments (for Scheduler use). 

 Install Sample Scheduler LIMS agent on the computer on which the LIMS 
will send the commands. 

Only one single Sample Scheduler LIMS agent must be installed for the 
entire application 

 Install Sample Scheduler client on every computer used by the operators. 
Several modules can be installed on the same computer. 

The Sample Scheduler configuration interface, which allows you to 
configure the application, is installed with the Sample Scheduler client. 
Therefore, install the Sample Scheduler client on all computers from which 
you wish to edit configuration parameters 
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 Install Sample Scheduler web interface on a computer on which you want 
to install the web interface. This will install the webserver as a service. You 
can deploy the webserver on any PC that has a CDS component installed: 

EZChrom client, AIC, or server 

OpenLab CDS 2.x client, AIC, or server 

The web interface will be available under the address 
https://<hostname>:52088/openlab/samplescheduler, or via Agilent 
Technologies > Agilent Sample Scheduler from the Start menu. 

   
    Figure 6 Sample Scheduler launch icon 

To avoid warnings when calling the https address, you need to install a 
trusted SSL certificate. For more information, see section “Install a Trusted 
SSL Certificate” on page 49 

Refer to the “Architecture” chapter on page 10 to learn more about these 
modules and to the “Sample Scheduler Deployment” chapter on page 22 to 
know on which computer to install the modules. 

Once the modules are selected, click Next. 
6 On the Destination Folder page, enter the path where the setup will install files. 

Then click Next. 

  
   Figure 7 Destination Folder page 
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7 For Sample Scheduler installation on EZChrom only:  

Provide the Sample Scheduler service account. 

  
   Figure 8 Scheduler Service Account (for EZChrom only) 

 Select Local System Account to keep the default Windows SYSTEM user. 
 Select User Account if you created an Instrument Service Account 

(Windows account) during the installation of EZChrom. Enter the 
credentials (username and password) for the created Service Account.  
Make sure that this Instrument Service Account has administrative 
privileges for actions related to machine configuration or certificate 
installation. 

8 For installation of Sample Scheduler database feature only: Identify the 
database instance (SQL Server or OpenLab Data Repository) used by the 
Sample Scheduler. 

Note that OpenLab Data Repository is available only for pure OpenLab CDS 
configurations without EZChrom. 
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To create or connect to a Sample Scheduler database instance in the SQL Server, 
proceed as follows: 

 

NOTE The "Scheduler Database" parameter for database access has to meet the database 
access requirements for all distributed Sample Scheduler components which need 
to access the database. It is not sufficient to meet the needs of the local services 
which are checked during the installation. Otherwise services on other computers 
may not be able to start after installation. 
The database access parameters can be adjusted after installation with the 
Database Access Reconfiguration Tool 
Agilent.Scheduler.Database.Access.Reconfiguration.exe, available from the \bin 
folder of the Sample Scheduler installation directory located only on the Shared 
Services server (default path: C:\Program Files (x86)\Agilent 
Technologies\Sample Scheduler for OpenLab\Bin). 

 

a As database type, select SQLServer. 

   
    Figure 9 SQL server instance information 

b Enter the SQL Server instance name: Different ways of connecting to the 
SQL Server are possible. Check with your IT department which one you 
should use. 
 Enter the name of the computer where the SQL Server is installed, and 

the name of the instance that should be used with Sample Scheduler 
for OpenLab: Computer Name\Instance Name 

 Enter the IP address of the computer where the SQL Server is installed, 
and the name of the instance that should be used with Sample 
Scheduler for OpenLab: IP address\Instance Name 

 Enter the name of the computer where the SQL Server is installed, and 
the associated port number: Computer Name, Port number. 
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c Select the authentication mode you desire: Windows Authentication or 
Database Authentication (To learn more about authentication mode, refer 
to “Appendix A: Microsoft SQL Server Configuration” on page 122). 
 If selecting Database Authentication (recommended) specify the 

database administrator, then click Test Database Connection. 
 If selecting Windows Authentication, click directly Test Database 

Connection. 

 

CAUTION If selecting Windows Authentication mode, the Sample Scheduler services will 
not be able to connect to the Sample Scheduler database with the default ‘Local 
System account’.  

Ask your system database administrator to assign a Windows account that has 
enough privileges to access the OpenLab Scheduler database (for example: 
sysadmin) to the following services: Agilent Sample Scheduler Agent, Agilent 
Sample Scheduler LIMS Agent, Agilent Sample Scheduler Orchestrator, and 
Agilent Sample Scheduler Webserver.  

Ensure also that all the Windows users that will log on to Sample Scheduler 
computers are also assigned the privileges to access the OpenLab Scheduler 
database. 

For detailed information about configuring the OpenLab Scheduler database 
users privileges, refer to “Appendix A: Microsoft SQL Server Configuration” on 
page 122. 

 

d The setup will check if the SQL Server\instance is reachable. If the 
connection is established, the setup checks if the Scheduler database 
already exists or not in the instance. If it exists, it proposes you either to 
keep the existing database or to create a new one (empty). Then click Next. 

 

NOTE Creating a new database will delete all stored analyses and reset the configuration 
parameters. 
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If you are experiencing troubles while connecting to the SQL Server instance 
(instance not reachable), do not hesitate to pause the installation and to check 
the SQL Server connectivity as described in “Appendix A: Microsoft SQL 
Server Configuration” on page 122. Once the connectivity is established, the 
installation can be resumed or re-launched. 

You can check the following parameters: 
 Credentials and connection mode,  
 Replace the computer name by its IP address (in case of a DNS issue) in 

the SQL Server Instance section,  
 Firewall for SQL Server (on the SQL Server computer), 
 TCP/IP Protocol for SQL Server instance (on the SQL Server computer). 
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To create or connect to a Sample Scheduler database instance in OpenLab Data 
Repository (OLDR), proceed as follows: 

a As database type, select OLDR. 

If you use OLDR as a database, Windows authentication is not available 
and disabled. 

    
    Figure 10 OLDR server instance information 

If using the OLDR option, the instance name is the Shared Services server 
name. Also the login name is set to a default name that cannot be 
changed. You only need to enter the password for the OLDR database. 
There are no restrictions regarding the characters and length of the 
password. If you are re-installing Sample Scheduler and want to keep the 
existing database, you must provide the credentials used for the first 
installation when the database was created. 

b Click Test Database Connection.  

The setup will check if the database instance is reachable. If the connection 
is established, the setup checks if the Scheduler database already exists or 
not in the instance. If it exists, it proposes you either to keep the existing 
database or to create a new one (empty). Then click Next. 

 

NOTE Creating a new database will delete all stored analyses and reset the configuration 
parameters. 
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9 For installation of Sample Scheduler LIMS agent only: 
 
On the LIMS Commands Folder page, enter the path where the LIMS will push 
the command files. Then click Next. 

  
   Figure 11 LIMS Commands folder 

 

NOTE If the folder used by LIMS to place the commands is located on a different 
computer than the one on which the LIMS agent is installed, enter: 
\\ComputerName\SharedFolderName or 
\\ComputerIPAddress\SharedFolderName. 
In this example, the ‘LIMS_Commands’ folder is created by the setup. 
It is possible to modify the LIMS commands afterwards. 
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10 On the Ready to Install page, click Install. 

  
   Figure 12 Ready to install 

11 Click Finish on the last page. 
12 If you are using an SQL Server instance for the Sample Scheduler database, 

configure the SQL Protocol for remote access to allow the Sample Scheduler 
database to be accessed from other computers than the one where it is 
installed. For more information, refer to “Configure SQL Protocol for Remote 
Access” on page 122. 

13 In regulated environment, create a service user (see “In a Regulated 
Environment: Create a Service User” on page 43). 

14 Activate Sample Scheduler. 

For details, see “Activate Sample Scheduler” on page 45.  
 

NOTE After the installation, the Scheduler Agent and LIMS Agent services are set to 
disabled. The services are set to automatically start when the Sample Scheduler is 
successfully activated. 
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Silent Installation 

Sample Scheduler supports a command-line mode for installation, also referred to 
as silent installation. This mode supports installation and uninstallation, repair and 
upgrade are not supported. You can execute silent installations either manually or 
as part of software management systems such as LANDesk or HP CM. 

Run Silent Installation 

Silent installation can be used by executing the Sample Scheduler .msi package 
with msiexec and providing the needed parameters for installation. 
1 Copy the content of the USB media to a centralized folder. 
2 Right-click the executable of the command prompt or Power shell prompt, and 

run it as administrator. 
3 Navigate to the drive where you have saved the content of the USB media. 
4 To start the installation, call msiexec with the required parameters (see tables 

below). 
5 Wait about 5 minutes while the installation takes place. To check the process of 

installation, look at the log files. By default, the log files will be in the same 
folder as the installer.  

If a required installable is missing, the installer will create an entry in a log file, 
and, depending on the component type, will continue or roll back the 
installation. An error code will be returned in such scenarios. 

6 After the installation has finished, reboot the PC.  
 

NOTE After the installation, the Scheduler Agent and LIMS Agent services are set to 
disabled. The services are set to automatically start when the Sample Scheduler is 
successfully activated. 
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Parameters 

Table 8 Mandatory Parameters 

 Parameter Name  Allowed Values Description 

ADDLOCAL SchedulerAgent 
SchedulerLimsAgent 
SchedulerClient 
SchedulerWebInterface 
SchedulerDatabaseAgent 
 
For CDS version ≤ 2.6: 
RoboHelp2011 
For CDS version > 2.6: 
RoboHelp2022 

Sample Scheduler component to be installed. 
To install multiple components at the same 
time, combine the values with a comma (“,”). 
For example: 
ADDLOCAL=SchedulerAgent,SchedulerClient 
To install also the Sample Scheduler Help use 
also "RoboHelp2011" or "RoboHelp2022" 
depending on the installed CDS version 

INSTALLDIR Any valid Windows path Directory where Sample Scheduler should be 
installed to. 

DATABASE_LOGON_TYPE For OLDR: 
“DatabaseAccount” 
For SQL Server: 
“DatabaseAccount” 
Or empty 

Database connection mode. 
If “DatabaseAccount” is specified for the SQL 
Server, you must provide 
DATABASE_USERNAME and 
DATABASE_PASSWORD as well. If nothing is 
specified for the SQL Server, the database 
connections will use the Windows Account 
under which the process runs that connects to 
the database. In this case you must set 
USEINTEGRATEDSECURITY to 1. 

DATABASE_TYPE SQLServer or OLDR Database type to be used to create the Sample 
Scheduler database instance. Note that OLDR 
is available only for pure OpenLab CDS 
configurations without EZChrom. 

DATABASE_USERNAME In the case of the SQL 
Server, any valid SQL 
Server Username 

DB account used by Sample Scheduler to 
connect to its database. 
For OLDR, the username is set as default and 
cannot be modified. 

DATABASE_PASSWORD Password of DB user Password of the DB user. 

DATABASE_SERVER Any string The name of the computer on which the 
database is installed, and the name of the 
instance that should be used with Sample 
Scheduler for OpenLab. 

USEINTEGRATEDSECURITY For OLDR: 0,  
For SQL Server: 0 or 1 

0: use - server with database credentials. 
1: use - server with Windows credentials. 
If Windows authentication is used, you must 
provide 
SERVICE_LOGON_FULLY_QUALIFIED_NAME 
and SERVICE_LOGON_PASSWORD as well. 
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Table 8 Mandatory Parameters 

 Parameter Name  Allowed Values Description 

CREATE_DATABASE 0 or 1 Set to 1 to create a new database. Only do this 
if no database for this version of Sample 
Scheduler has been created yet on the DB 
instance. Otherwise the existing database will 
be overwritten. 

 

Table 9 Optional parameters 

Parameter Name Allowed 
Values 

Description 

SERVICE_LOGON_FULLY_QUALIFIED_NAME Windows 
NT User 
account 

User account that should be used for the 
Sample Scheduler service. In a regulated 
environment, this is the Sample Scheduler 
Service user. 
Provide this parameter if Services should be 
started with a user that is not “Local 
System”, for example, in case of EZChrom 
Agents or if the LIMS agent needs to access 
a network share. 

SERVICE_LOGON_PASSWORD Windows 
NT User 
password 

Password for the 
SERVICE_LOGON_FULLY_QUALIFIED_NAME. 
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Example 1: Sample Scheduler database instance is managed by SQL Server 
 First Step: Installation of Lims Agent and Webserver with database creation: 

Msiexec -I Agilent.Scheduler.Install_EN.msi 

ADDLOCAL="SchedulerLimsAgent,SchedulerDatabaseAgent,SchedulerWebInterfac

e" INSTALLDIR="C:\Scheduler" DATABASE_LOGON_TYPE="DatabaseAccount" 

DATABASE_TYPE="SQLServer" DATABASE_SERVER="servername\sqlexpress" 

DATABASE_USERNAME="sa" DATABASE_PASSWORD="Password123" 

USEINTEGRATEDSECURITY="0" CREATE_DATABASE="1" /q /lxv "log.txt" 

 Install Sample Scheduler Agent on another machine: 
Msiexec -I Agilent.Scheduler.Install_EN.msi ADDLOCAL="SchedulerAgent" 

INSTALLDIR="C:\Scheduler" /q /lxv "log.txt" 

 Install Sample Scheduler Client on another machine: 
Msiexec -I Agilent.Scheduler.Install_EN.msi ADDLOCAL="SchedulerClient" 

INSTALLDIR="C:\Scheduler" /q /lxv "log.txt" 

 Uninstallation:  
   Msiexec -X Agilent.Scheduler.Install_EN.msi –q 

Examples 2: Sample Scheduler database instance is managed by OLDR 
 Installation of Lims Agent and Webserver with database creation: 

Msiexec -I Agilent.Scheduler.Install_EN.msi 

ADDLOCAL="SchedulerLimsAgent,SchedulerDatabaseAgent,SchedulerWebInterfac

e" INSTALLDIR="C:\Scheduler" DATABASE_LOGON_TYPE="DatabaseAccount" 

DATABASE_TYPE="OLDR" DATABASE_SERVER="servername,port" 

DATABASE_NAME="datarepo" DATABASE_USERNAME="openlabschedulerxxx" 

DATABASE_PASSWORD="Password123" USEINTEGRATEDSECURITY="0" 

CREATE_DATABASE="1" /q /lxv "log.txt" 

 
 

NOTE In the DATABASE_USERNAME replace the xxx with the current revision number 
without dot, for example openlabscheduler270. 

 

  



Installation 

Sample Scheduler for OpenLab 43 
  

Software Verification Check 

To qualify the Sample Scheduler for OpenLab installation, launch the Agilent 
Software Verification Tool (from Agilent Technologies/Software Verification Tool). 

Automatic Generation of Installer Logs 

An installation log file is created automatically during a new installation or upgrade. 
The log file is created both during installation by the set-up wizard and in silent 
mode. The installation log file remains on the system even after uninstallation. 

The installation logs are located in the \ProgramData\Agilent\Sample Scheduler 
for OpenLab\InstallLogs folder. 

You can manually collect and export installation log files from the local computer in 
Sample Scheduler configuration (Maintenance ribbon tab > Save all Logs). For 
more information, refer to Sample Scheduler online help (search for "Save all log 
files"). 

In a Regulated Environment: Create a Service User in OpenLab 

1 In the Control Panel (Administration > Roles and Users), create a new role 
Operator: 
a Enter Operator as role name and Laboratory Operator as description. 
b Assign the following project privileges to this role: 

 View project or project group (Role type Project > Project 
Management), enabled by default, cannot be disabled 

 Edit content of project (Role type Project > Project Management) 
 Create and modify sequence (Role type Project > Sequence) 

2 In the Control Panel (Administration > Users), create a new service account 
user: 
a Enter Sample Scheduler Service as a login name and Account used by the 

Sample Scheduler services as a description. 
 

NOTE This user is required to successfully run Sample Scheduler for OpenLab. Do not 
disable this user as long as you use Sample Scheduler for OpenLab in your 
laboratory environment. 

 
b Assign the following roles to this user: 

 Instrument User (built-in role) 
 Operator (created in step 1) 
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3 Assign the Sample Scheduler Service user to all instruments and projects used 
with Sample Scheduler for OpenLab. For more information, refer to the Control 
Panel online help (search for “Set Privileges”). 

4 Assign the Sample Scheduler Service user to the Sample Scheduler services:  
a In Sample Scheduler configuration, navigate to the Maintenance tab and 

select Update OpenLab Services Credentials.  
b Enter the credentials of the Sample Scheduler Service user. For more 

information, refer to Sample Scheduler online help (search for “Service 
Credentials”). 

  
 Figure 13 Update service credentials. 
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In a Regulated Environment: Restrict Access to LIMS Result Folder 

If you use a LIMS system, access to the LIMS Result folder must be restricted at 
operating system level. There will be reports created in this folder, and only the 
LIMS system should be allowed to access these reports. 

To restrict access, ensure the following: 
 A specific Log On user is specified in the properties of the Agilent Sample 

Scheduler LIMS Agent service.  
 This user has Read and Write access to the LIMS Result folder.  
 Access to the LIMS Result folder is restricted for other users. 

Activate Sample Scheduler 

As long as Sample Scheduler is not activated the number of concurrent user 
sessions is limited to five, and several functions are inactive. Activate Sample 
Scheduler to explore it in a training mode. 

Activation includes the following: 
 The entered Sample Scheduler service credentials are applied. 
 The system creates Sample Scheduler roles & privileges 
 The system automatically assigns your instruments 
 Scheduler Agent and LIMS Agent services are started, and the startup type is 

set to Automatic. 
 The limit on the number of concurrent user sessions is removed. 
 The start menu entry Agilent Technologies > Agilent Sample Scheduler 

proceeds directly to the login screen, skipping the information page in the 
future. 

 

NOTE The activation alone does not enable you to submit analysis requests to 
instruments. Ensure you have the required licenses (60 days trial license or Sample 
Scheduler Expansion pack). 

 
 

NOTE During activation all instruments are automatically assigned. To only assign a 
subset of instruments, deselect the check box Instruments are assigned 
automatically and assign instruments afterwards during the configuration. 
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Prerequisites: 
 To be able to carry out the procedure as described, you need the privilege 

Manage Security (Shared Services). Privileges are configured in the OpenLab 
Control Panel. 

To activate Sample Scheduler: 
1 In a regulated environment: Create a service user for Sample Scheduler before 

activation. See “In a Regulated Environment: Create a Service User” on page 43. 
2 Ensure that all Instrument Controllers can be pinged. 

a In the OpenLab Control Panel, select Administration > Instrument 
Controllers. 

b Select each Instrument Controller and click Ping Instrument Controller. 
3 Open the Sample Scheduler Web Interface 

The web interface is available under the address 
https://<Scheduler_webserver>:52088/openlab/samplescheduler 

4 Log in as a user that has the Manage Security (Shared Services) privilege. 
5 In the menu, click Activation. 
6 In a regulated environment: Enter username and password of the Sample 

Scheduler Service user. Otherwise, use the built-in OpenLab CDS administrator. 
In a Windows domain environment, also provide the domain. 

7 Click Activate. 

A success message opens. 
8 To apply the changes to your user session, log in again. 
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5 Post Installation Tasks 

Configure Antivirus Program 

If you use an antivirus program with behavior monitoring, add the files below to the 
list of approved programs: 
 C:\Program Files (x86)\Agilent Technologies\Sample Scheduler for 

OpenLab\Bin\Agilent.OpenLab.Scheduler.Client.exe 
 C:\Program Files (x86)\Agilent Technologies\Sample Scheduler for 

OpenLab\Bin\Agilent.OpenLab.Scheduler.Configuration.exe 
 C:\Program Files (x86)\Agilent Technologies\Sample Scheduler for 

OpenLab\Bin\Agilent.Scheduler.Acquisition.Agent.exe 
 C:\Program Files (x86)\Agilent Technologies\Sample Scheduler for 

OpenLab\Bin\Agilent.Scheduler.Agent.exe 
 C:\Program Files (x86)\Agilent Technologies\Sample Scheduler for 

OpenLab\Bin\Agilent.Scheduler.Lims.Agent.exe  
 C:\Program Files (x86)\Agilent Technologies\Sample Scheduler for 

OpenLab\Bin\Agilent.Scheduler.WebserverService.exe 
 C:\Program Files (x86)\Agilent Technologies\Sample Scheduler for 

OpenLab\Bin\Agilent.Scheduler.Webstarter.exe 
 C:\Program Files (x86)\Agilent Technologies\Sample Scheduler for 

OpenLab\Bin\Agilent.Scheduler.DBManagement.Agent.exe 
 C:\Program Files (x86)\Agilent Technologies\Sample Scheduler for 

OpenLab\Bin\Agilent.Scheduler.Orchestrator.exe 
 C:\Program Files (x86)\Agilent Technologies\Sample Scheduler for 

OpenLab\Bin\Agilent.ICDS.Remote.Satellite32.exe 
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Start Services 

Start LIMS Agent Service 

If you installed the LIMS agent manually (that is, you do not use the LIMS agent that 
is automatically installed with OpenLab CDS): 
1 Set the startup type of the LIMS agent service to Automatic. 
2 Start the LIMS agent service. 

Start Sample Scheduler Agent 

If you deployed an additional Analytical Instrument Controller (AIC) in your OpenLab 
CDS system: 
1 Set the startup type of the Sample Scheduler agent service to Automatic. 
2 Start the Sample Scheduler agent service. 

 

NOTE To start the Sample Scheduler agents, first ensure that the Sample Scheduler 
Webserver is running. 

 

When adding a new AIC to the system after the Sample Scheduler is already 
activated: 
1 Open the Sample Scheduler configuration. 
2 Open the Maintenance tab. 
3 Click Update OpenLab Service Credentials. 
4 Enter valid credentials for the OpenLab Services user. 
5 Click Save. 
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Configure LIMS Transfer 

If you want to use the Sign-Off for LIMS feature, the following requirements must be 
met: 
 A LIMS result folder must be available, to which the result reports are copied 

and then collected by the LIMS. The folder can be located on any computer. 
The LIMS agent does not necessarily run on the computer that hosts the LIMS 
results folder. 

 A folder path must be defined that allows the LIMS agent to access the LIMS 
result folder. This path must be defined on the computer where the Sample 
Scheduler LIMS agent is installed. 

 The LIMS agent collects all files with the specified extension (for example, csv, 
txt) regardless of the name. For dual injections assigned with front and back, 
the name of the report file is extended with 01 and 02, respectively. 

Install a Trusted SSL Certificate 

An SSL certificate is required to allow https connections on the web server. By 
default, Sample Scheduler uses the already installed SSL certificate of OpenLab 
CDS. This certificate is a so-called self-signed certificate. Therefore, you will receive 
a warning message from your browser if you start the web interface from outside 
the CDS system. In addition, your browser indicates in the navigation bar that the 
website is not trusted. 

 
  Figure 14 Warning navigation bar 

The webserver of the Sample Scheduler also works properly with this warning. If 
you want to get trusted https connections, you need to install a trusted certificate 
(from your browser) on the Sample Scheduler webserver. 
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Install an SSL Certificate in the Windows Keystore 
 

NOTE This procedure is not required when installing a custom certificate using certificate 
service procedures. See certificate service documentation instead. 

 

You need a certificate issued by a trusted certification provider. The format must 
match one of the supported formats for your Windows operating system (for 
example, PKCS #12 or PKCS #07). 
1 Open the Microsoft Management Console (mmc.exe).  
2 Add the certificate snap-in for your computer account (File > Add/Remove 

Snap-in). 
3 Go to Personal\Certificates, in the context menu under Action > All Tasks, 

select the option Import.  
4 Import the certificate into your Personal store:  

a Double-click on the installed certificate to launch the Details dialog.  
b Retrieve the thumbprint from the Details tab (for example, thumbprint: 

c42b1719d979c024d08402b9c894c894c973295dc9f6). 
c Save the thumbprint in a text file. 
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Assign Trusted SSL Certificate to the Sample Scheduler Webserver 

1 Log in to the computer on which the Agilent Sample Scheduler webserver is 
running.  

2 Stop the service of the webserver (in Services under Agilent Sample Scheduler 
Webserver). 

3 Open the command line window with administrator rights. 
4 To show the current SSL certificate bindings, enter:  

 

   netsh http show sslcert 
 

5 Copy the application ID of the binding from port 52088 into a text file that you 
will need later (for example, application ID: {12345678-db90-4b66-8b01-
88f7af2e36bf}). 

6 Remove the binding to the old certificate with the following command:  
 

   netsh http delete sslcert ipport=0.0.0.0:52088 
 

7 Once the binding is removed, add a new binding to the new certificate: 
 

   netsh http add sslcert ipport=0.0.0.0:52088 appid=APPID  
   certhash=THUMBPRINT 

 

NOTE APPID is the previously saved application ID, including the curly brackets. 
THUMBPRINT is the previously saved thumbprint of the certificate, it must not 
contain any blank spaces, and you must also make sure that no leading question 
mark appears when inserting it into the command line. 

 

8 Start the service of Sample Scheduler webserver. 
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Disable Legacy SSL Versions 

Sample Scheduler webserver uses the HTTP.sys server built into Windows. This 
way, Sample Scheduler uses the default settings according to the Windows version 
on which it was installed. 

Depending on your company's IT policy, you may need to disable legacy SSL 
versions when using the webserver. To disable individual protocol versions on 
Windows, follow the instructions at https://docs.microsoft.com/en-us/windows-
server/security/tls/tls-registry-settings#tls-10 

Use Sample Scheduler Lab Balance Bridge 

The Lab Balance Bridge installer is available via subscribeNet. You need to start this 
installer independently from the Sample Scheduler installer. 

See “Appendix B: Sample Scheduler for OpenLab Lab Balance Bridge” on page 145 
for further information. 

https://docs.microsoft.com/en-us/windows-server/security/tls/tls-registry-settings#tls-10
https://docs.microsoft.com/en-us/windows-server/security/tls/tls-registry-settings#tls-10
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6 Configuration of Specific Sample Scheduler 
Settings 

User Privileges 

The configuration of the Sample Scheduler user privileges is performed in the 
Control Panel. 

The privileges described in the following can be associated with different roles in 
the Control Panel. The following roles are available:  
 Sample Scheduler Administrator: The privileges associated with this role allow 

you to configure the Sample Scheduler. For example, you can define default 
settings and mandatory commands, establish the LIMS connection (LIMS 
Commands folder or SQL statements), monitor notifications, and create Auto-
fill templates. 

 Sample Scheduler Analyst: The privileges associated with this role allow you to 
manage the entire laboratory workload as you have insight into the workload of 
all instruments and their users. You can review the results in the CDS for 
reprocessing. 

 Sample Scheduler Technician: The privileges associated with this role allow you 
to manage the instruments and determine the analysis workflow (for example, 
you can create, change, delete, reset or restart analyses and sequences, set 
their priority, merge single or split dual analyses, and correct instrument errors). 
You have access to the data in the CDS.  

 Sample Scheduler Operator: The privileges associated with this role allow you 
to prepare analyses/sequences, determine the vial position, select the 
instrument, and stop it in case of failure. With this role and this area of 
responsibility, you can work exclusively in the web interface. 

The administrator of the OpenLab system can edit these roles or create new ones 
and assign them to the different Sample Scheduler users. 
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Table 10 List of privileges 

Privilege Description 

Add analysis (Sample Scheduler) Allow the user to use the Add button 

Change priority (Sample Scheduler) Allow the user to use the Sooner / Later buttons 

Create sequence (Sample Scheduler) Allow the user to use the Create sequence button 

Delete notification (Sample Scheduler) Allow a user to use the Delete buttons 

Delete analysis (Sample Scheduler) Allow the user to use the Delete button 

Is an administrator (Sample Scheduler) Allow the user to connect to Sample Scheduler 
configuration 

Edit analysis (Sample Scheduler) Allow the user to be displayed in the Assign User (client), 
Assign to (web interface), and OpenLab default user 
(configuration) drop-down lists 
Allow the user to schedule, pause, stop, and restart 
analyses or sequences 
Allow the user to stop instruments 

Merge / Split analysis (Sample Scheduler) Allow the user to Merge and Split analyses 

Open data (Sample Scheduler) Allow the user to open data in the CDS from the Sample 
Scheduler 

Perform actions on sequence (Sample 
Scheduler) 

Allow the user to use the actions button in the Sequence 
grid (add, delete, convert, etc.) 

Reset analysis (Sample Scheduler) Allow the user to use the Reset button 

Restart analysis (Sample Scheduler) Allow the user to use the Restart button 

Review & submit results (Sample 
Scheduler) 

Allow the user to submit results to LIMS 

Schedule analysis (Sample Scheduler) Allow the user to use the Schedule button 

Set Favorites for all users (Sample 
Scheduler Web Interface) 

Allow the user to use the Set Default Favorites button 

Stop / Stop instrument (Sample Scheduler) Allow the user to use the Stop and Stop Instrument 
buttons 

View activity log Allow the user to view the activity log. Required to view 
error information for instruments in the dashboard. 

View all Analysis Details (Sample Scheduler 
Web Interface) 

Allow the user to view the tabs of the categories and their 
parameters in the Details pane of the Sample Scheduler 
web interface  
The Favorites tab is visible for all users 
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Table 10 List of privileges 

Privilege Description 

View and edit other users' analyses 
(Sample Scheduler) 

Allow the user to view and edit analyses that are 
assigned to other users; analyses with no user entry are 
visible for all users 
Allow the user to view other users in the Assign User 
(client) and Assign to (web interface) drop-down list with 
which analyses and sequences are assigned 

View lab manager start page (Sample 
Scheduler Web Interface) 

Allow the user to view the start page of the Lab manager 

View report (Sample Scheduler) Allow the user to use the View PDF button in the Review 
ribbon tab of the Sample Scheduler client 

Wait analysis (Sample Scheduler) Allow the user to use the Wait button 
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Audit Trail 

Enable Audit Trail 

After installing or upgrading Sample Scheduler, the audit trail is disabled by default. 
Proceed as follows to enable the audit trail: 
1 In Sample Scheduler configuration, go to the System Configuration tab. 
2 For the parameter Enable Audit Logging, select True. 

 

CAUTION Once you have enabled the audit trail, you can no longer disable it. 

Audit Trail Settings 

If the Write activity log option is enabled for your CDS, every action in the Sample 
Scheduler will be recorded in the System Activity Log of the Control Panel. For the 
audit trail to function correctly, Sample Scheduler needs specific audit trail settings 
in the CDS project. Proceed as follows to ensure that the settings are correct:  
1 In OpenLab Control Panel, click Projects and select the project to edit.  
2 On the CDS settings tab, expand the Audit Trail Settings section.  
3 Select the Sequence tab.  

Only the Sequence Audit Trail settings are relevant for Sample Scheduler.  

If reasons are required, Sample Scheduler will automatically enter its own 
default reasons to the entries. Therefore, ensure that either no reasons are 
required, or users can enter their own reasons: 
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   Figure 15 No reasons required 

 
   Figure 16 Allow own reasons 

 

NOTE Only users with a role containing the View activity log permission are able to view 
the activity log and all its entries. By default, these roles are Activity Log Access 
and Everything. 
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Enable Single Sign-On 

If Single Sign-On is enabled, you do not need to provide credentials to start Sample 
Scheduler configuration or Sample Scheduler client. This feature is available if you 
use Windows Domain authentication. 

To enable Single Sign-On: 
1 In the Control Panel under Administration > System Configuration, set the 

authentication provider to Windows Domain. 

For more information, refer to the Control Panel online help (search for “set the 
authentication provider”). 

2 In the Control Panel under Administration > Set Security Policy, enable Single-
On for the system. 

3 Import the domain users. 

For more information, refer to the Control Panel online help (search for “import 
users”). 

Once you have enabled Single Sign-On for the system, you can enable and disable 
Single Sign-On for each local computer (in the Control Panel under Administration > 
Local Configuration). To learn more about how to enable Single Sign-On, refer to 
the Control Panel online help (search for “single sign on”). 
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7 Upgrade 

To upgrade from a previous version of Sample Scheduler, shut down all 
components of the Sample Scheduler system at the same time. First stop all the 
services, then upgrade every computer. This can be done without special 
preparation. Analyses that were in the old system will not be available on the new 
system. 

 

NOTE After the upgrade procedure finishes, you need to activate Sample Scheduler to 
make the system ready for use. 

Upgrade to Sample Scheduler version 2.7 is possible for installations of Sample 
Scheduler version 2.4 or higher. 

After the upgrade: 
 All previously installed components remain and are upgraded 
 Sample Scheduler database feature is added/upgraded 
 The web server is always installed on the server 
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Upgrade with CDS Master Installer 

Version 2.6 or lower: Sample Scheduler was not automatically upgraded when 
upgrading OpenLab CDS using the CDS Master Installer. 

Version 2.7: When upgrading Sample Scheduler using the CDS installer, Sample 
Scheduler is always upgraded to the corresponding Sample Scheduler version 
provided by the CDS installer. This happens even if Sample Scheduler was activated 
and used with a previous Sample Scheduler version. 

For details on the installation, see the instructions in OpenLab CDS Clients and 
Instrument Controllers Installation and Configuration (CDS_v2.7_ClientAICGuide). 

 
 

NOTE After the upgrade, you must activate Sample Scheduler again. 
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8 Migration 
 

NOTE Migration from all previous versions to the current Sample Scheduler version is 
supported. However, migration from OLDR to MS SQL is not supported. 

 

Migration Tools for Moving from EZChrom to 
OpenLab CDS  

Moving from EZChrom to OpenLab CDS is now supported with a set of tools to help 
you move all your data, methods, and report templates into the new system. The 
tools support the move from EZChrom to OpenLab CDS. These tools help you 
move to the new system by creating an export package of all the EZChrom data 
and importing them into the new CDS version. The data is organized in projects 
created by the tool. In addition, all your configuration information is captured and 
moved. This means that all your users, groups, roles, permissions and instrument 
configurations are moved over and installed on the new system. This significantly 
reduces the time and effort needed for this transition. 
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EZChrom to OpenLab CDS with Sample Scheduler 

Supported transitions: 
 From: 

EZChrom, 

with Sample Scheduler, rev. A.02.01 or A.02.02 
 To:  

OpenLab CDS, 

with Sample Scheduler for OpenLab, rev 2.1 or higher 

When moving from EZChrom with Sample Scheduler to OpenLab CDS with Sample 
Scheduler, the most important files will be the methods. The migration tool 
replicates your projects in the new software and moves all the methods into the 
correct projects. Entire configuration settings and instrument setting are moved as 
well. All that is needed is the process of converting the methods to CDS methods. 
This is done with the import functions within both Acquisition and Data Analysis. 

Additional Information 

For additional information about EZChrom to OpenLab CDS migration: 
 See Agilent Migration Tools for OpenLab - Workstations to OpenLab CDS 

Workstation (OpenLabMigrationTool_en.pdf) on the OpenLab CDS installation 
medium. 

 See OpenLab Help & Learning (Under How To > OpenLab CDS > Data Analysis 
> Migration). 

Please check the following web site for your local sales and support contact: 
http://www.agilent.com/en-us/contact-us/page 

http://www.agilent.com/en-us/contact-us/page
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Data Migration Utility for Upgrading the Sample 
Scheduler Database 

 

NOTE Activate the upgraded system before using the migration tool. 
 

When upgrading Sample Scheduler to the latest revision, use this tool to migrate 
the existing configuration and analyses from the old Sample Scheduler database to 
the newly installed Sample Scheduler database.  

The upgrade uses the database type that was specified during the Sample 
Scheduler installation. 

The Data Migration Utility is provided in the installation package under the Support 
folder. It contains an executable which supports the migration of the following data: 
 Auto-Fill templates 
 The settings from the System Configuration module of the Sample Scheduler 

configuration 
 The settings of the Commands module of the Sample Scheduler configuration 
 The settings of the LIMS module of the Sample Scheduler configuration 
 The settings of the Instrument Groups module of the Sample Scheduler 

configuration 
 Notifications about invalid commands generated by the LIMS 
 Analyses and sequences in Waiting, Stopped, and Incomplete state of the 

Sample Scheduler client 



Migration 

64  Sample Scheduler for OpenLab  
 

Registration Tool 

The following information is only relevant if you installed the Sample Scheduler 
automatically together with CDS 2.6 and higher. 

The CDS 2.6 installation generated a random Sample Scheduler password. When 
migrating the database to the current Sample Scheduler version, you will need this 
password. To replace this randomly generated password with a user-generated 
password, use the Data Repository Registration Tool. 
1 Navigate to the subfolder RegistrationTool in the installation path. 
2 Execute Agilent.OpenLab.DataRepository.RegistrationTool.exe.  
3 To replace the password, use the following command (replace NewPassword 

with the password of your choice):  
   Agilent.OpenLab.DataRepository.RegistrationTool.exe 
   DbRegister --AppName "openlabscheduler260" ––AppPassword 
   "NewPassword" --Overwrite  --AppKey 
   "HKEY_LOCAL_MACHINE\SOFTWARE\Agilent\Scheduler260" 

4 Note down the new password in a secure location. 
5 Use the new password when you run the Data Migration Utility.  

Run the Data Migration Utility 

1 Run the executable on the server on which you want to migrate the Sample 
Scheduler database. 

2 Enter the Server Instance on which the Sample Scheduler database is located 
(the database server and instance name is displayed in Sample Scheduler 
configuration in the Deployment tab).  
Different ways of connecting to the SQL Server are possible. Check with your IT 
department which one you should use. 
 Enter the name of the computer where the SQL Server is installed, and the 

name of the instance that should be used with Sample Scheduler for 
OpenLab: Computer Name\Instance Name 

 Enter the IP address of the computer where the SQL Server is installed, and 
the name of the instance that should be used with Sample Scheduler for 
OpenLab: IP address\Instance Name 

 Enter the name of the computer where the SQL Server is installed, and the 
associated port number: Computer Name, Port number. 
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3 Specify the SQL authentication account and enter the corresponding 
credentials (user name and password) of the database administrator.  

The data migration utility searches for the database. It only reads from the 
source database. It does not delete any records, database tables or databases. 

If the connections were specified correctly and the databases are accessible, 
the detected version appears under Migratable Scheduler Version. 

4 If multiple database versions are available, select the Migratable Scheduler 
Version from the drop-down list. 

5 If you have any configuration settings (for example, commands, LIMS 
configurations, LIMS database queries, Instrument groups, notifications) to 
migrate, do this first before importing analyses, sequences, or templates. 
a To import configuration settings, select Migrate Configurations. 

 

NOTE If you migrate the configurations of Sample Scheduler version 2.4 to a higher 
version, you will be asked to enable audit logging. In this dialog, select Yes if you 
want to enable the audit logging, or select No if you want to continue without audit 
logging. You can also enable the audit trail later in Sample Scheduler configuration. 

 

The migration tool checks the existing settings of the target system. The 
number of migrated configurations, commands, and notifications is displayed 
after migration. 

If instrument groups are also migrated, both the number of existing groups and 
the number of instruments (instrument group lines) are displayed. 

6 If you want to migrate analyses or sequences, you must specify a path under 
which a csv file with their identifiers is to be exported. 
a Click the button Export identifiers to CSV. The identifier as well as given 

mandatory parameter values (for example, project, instrument, injection 
source) of the analyses and sequences will be exported to the csv file. 

b If necessary, make changes to the file, for example, by limiting only the 
analyses and sequences of a specific instrument in the file. Save your 
changes and keep the file in the above specified path. 

c Select Migrate Specified Analyses to start the import of the identifiers.  

The migration tool checks the existing analyses of the target system. The 
number of migrated analyses is displayed after migration. 
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7 If you want to migrate templates, select Migrate Analyses Templates. 

The migration tool checks the existing templates of the target system. The 
number of migrated templates is displayed after migration.  

8 To monitor the migrated elements, you can compare the number of migrated 
items with the number of actual records available for migration in the old 
database. 

9 After the migration is finished, open Sample Scheduler configuration on the 
target system to confirm the successful migration. 

10 Open the Sample Scheduler client on the target system to verify that all desired 
analyses and sequences have been migrated. 
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9 Uninstallation 

To uninstall the application, you can either launch the setup and select the Remove 
option, or uninstall it from the Microsoft Control panel. 

All the files installed by the setup will be deleted, and the registry key is removed. 

The Sample Scheduler database stays intact. 

If your topology includes multiple OpenLab servers, uninstall Sample Scheduler 
from those servers that do not host Shared Services. Alternatively, disable the 
Sample Scheduler Webserver service on those servers. 
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Uninstall Plugin in the CDS OpenLab Acquisition 

The script can be executed to remove the Sample Scheduler button from the 
Acquisition clients on the specific machine. 

 

$ErrorActionPreference = "stop" 
$installDir = "not found" 
 
Try { 
    $installDir = Get-ItemProperty -Path 
HKLM:\SOFTWARE\ChromatographySystem\OpenLABAcq 
} 
Catch [System.Management.Automation.ItemNotFoundException] 
{  
    $installDir = Get-ItemProperty -Path 
HKLM:\SOFTWARE\WOW6432Node\ChromatographySystem\OpenLABAcq 
} 
 
Write-Output "Found Acquisition, installed on:" 
Write-Output $installDir.ChromDir 
 
$schedulerFile = Join-Path -Path $installDir.ChromDir -ChildPath 
"Layouts\AcquisitionClient.workspace.extensions\Agilent.Scheduler.Acquis
ition.Plugin.xml" 
if ($installDir -ne "not found") { 
    try { 
         $destination = $schedulerFile + ".old" 
         Move-Item -Path $schedulerFile -Destination $destination 
         Write-Output "Sample Scheduler extension succesfully disabled" 
    } catch { 
        Write-Warning "Could not move extension file  $($schedulerFile), 
make sure to run this with Administrator privileges" 
    } 
} 
else { 
    Write-Warning "Could not find OpenLab Acquisition Installation 
directory" 
} 
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10 LIMS Command: Analysis Order generated by 
the LIMS 

A command is an analysis order generated by the LIMS, leading to the analysis of a 
sample by OpenLab CDS or EZChrom via the Sample Scheduler. 

Two types of commands are handled: 
 XML commands generated by the LIMS and respecting the Scheduler XML 

command structure. 
 Commands collected from the LIMS database by a periodically executed SQL 

query as defined in the Sample Scheduler configuration. 

Both command types are handled by the Sample Scheduler (Scheduler LIMS agent) 
in the same consistent way.  
 Collection of the command  
 Checking the command validity 
 Creation of an analysis in the Sample Scheduler database 

 

NOTE If you used to work with Sample Scheduler for OpenLab CDS A.02.x (that is, in 
combination with earlier versions of EZChrom): 
XML commands and SQL queries can remain unchanged. The existing structures 
can be used as is, the current version of Sample Scheduler for OpenLab is 
backwards compatible. A new parameter Identifier will be added that contains the 
sample name. 

 

 

NOTE If you use a mixed configuration with EZChrom and OpenLab CDS, the same XML 
commands and LIMS database queries can be used regardless of the CDS. 
If an EZChrom project is specified: 
Make sure that only EZChrom methods and EZChrom instruments are used in this 
XML command/database query. 
If it contains parameters that are not supported by EZChrom, these values will be 
removed by Sample Scheduler. 
Commands with inconsistent data are ignored and deleted. 
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XML Commands 

This chapter describes the XML scheme the LIMS must respect when it generates 
XML commands. 

The structure of an XML file is defined to fit the CDS instrument/method 
architecture. 

Sample Scheduler for OpenLab manages two types of XML files: 
 XML commands, that handle: 

 The analysis of a sample with OpenLab CDS or EZChrom, 
 The population of the Auto-Fills table with Auto-fill templates (to be used to 

automatically fill incomplete commands). 
 XML actions that initiate an action, for example: 

 Deleting an analysis, an entire sequence, or an analysis with a matching 
identifier from a sequence 

 Creating a sequence from a group of analyses 
 Creating an instrument group 

The XML scheme is also described in the Sample Scheduler for OpenLab 
Command Guide (in the installation folder under 
Documentation\xml\Sample_Scheduler_for_OpenLab_Command_Guide.chm). 

Encoding 

Always declare the correct encoding in the XML file. To see how to declare the 
encoding, refer to the Advanced_Command.xml example in the 
Documentation/xml folder. 

 

NOTE If you do not specify the encoding, the file is treated as UTF-8. This may lead to 
issues if the xml was not saved as UTF-8. 
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High Level XML Command Structure 

The XML command matches the way one sample is analyzed: 

On one instrument configured with one Injection source 

It must conform with the following high-level structure: 

 
  <SchedulerCommand> 
 
   <Template>false</Template> 
   <Identifier></Identifier> 
   <SampleName></SampleName> 
   <State></State> 
   <Project></Project> 
   <User></User> 
   <Replicates></Replicates> 
         … 
   <Tasks> 
          <Task> 
      <Towers> 
                             <Tower> 
                             </Tower> 
             
       
 
      </Towers> 
           </Task> 
 
   </Tasks> 
 
  </SchedulerCommand> 

 
  

By 
instrument 

General Sample 
Parameters 

By Tower: 
Acquisition parameters, 

Sample information, 
Calibration, Variables 



LIMS Command: Analysis Order generated by the LIMS 

72  Sample Scheduler for OpenLab  
 

 The General parameters are the parameters defined for the entire sample. 
 The Task parameters are related to one instrument. In most cases only one 

task is defined by XML command as the sample acquisition is performed on 
one instrument. For some applications (for example, online gas analysis), the 
sample can be analyzed by two coupled instruments simultaneously. In this 
case, two tasks are defined in the XML command. A maximum of two tasks 
can be handled by the XML command. 

 The Tower parameters are related to one injection source of the instrument. 
Acquisition parameters, sample information, calibration parameters and 
internal standards are defined in this section. 

If the instrument is configured with two Injection sources, two Tower sections must 
be defined in the XML command. 

Restart an Analysis from the LIMS 

If the LIMS offers this function, you can restart analyses or sequences that are in 
Ended, Error, or Stopped state. Configure the LIMS to supply the same information 
in the XML as on the first submission to the Scheduler. Only the Identifier needs to 
be changed, since it must be unique. 
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Basic XML Command 

The basic command lists the minimum set of parameters that need to be defined in 
an XML command to allow the CDS to perform the analysis.  

The prerequisite to use such a command is to define a value for all the following 
default parameters in Sample Scheduler configuration/System configuration: 
OpenLab default user, OpenLab default project, Default Sample name, Default 
data file, Default result path, and Default result name parameters. 

 
<SchedulerCommand>  
 <Identifier>LIMS_ID</Identifier> [Sample Identifier    
 generated by the LIMS] 
  <Tasks>  
   <Task>  
    <InstrumentMethods>  
     <InstrumentMethod>  
      <InstrumentName> 
       OpenLabValidInstrument 
      </InstrumentName>  
      <AcquisitionMethodName> 
       OpenLabValidMethod.amx 
      </AcquisitionMethodName> 
     </InstrumentMethod>  
    </InstrumentMethods>  
     

    <Towers>  
     <Tower> 
      <InjectionSource> 
       InjectionSourceName 
      </InjectionSource> 
      <SampleInfo> 
       <UseMethodInjectionVolume> 
        true 

NOTE [Use the injection volume defined in CDS Acquisition method] 

       </UseMethodInjectionVolume>  
       <Vial>1</Vial>  [Autosampler position] 
      </SampleInfo> 
     </Tower> 
    </Towers> 
   </Task>  
  </Tasks>   
</SchedulerCommand> 
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An XML template is provided to help you build a command: <Scheduler Install 
path>/Documentation / Basic_Command.xml. 

 

NOTE The InstrumentName tag is case sensitive. If the case is different from the one 
defined in the Control Panel, the XML command will be considered as not valid, and 
sent to the <LIMS_Commands>/Trash folder. 

 

NOTE If you are using an EZChrom System, the value of the InjectionSource tag should 
only be set to Front, Back, or Dual. 
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Advanced XML Command 

The XML command allows you to define many parameters used to perform the 
acquisition (vial, injection volume…) and the processing (multiplier, sample 
amount…). In the XML command, you can set up an analysis with the instrument 
groups configured in the Sample Scheduler configuration. Later, when the analysis 
is edited in the Analysis table, you can switch between the instruments (and their 
associated parameters) of this group. The XML command also allows you to define 
an instrument group that consists of specific instruments for a particular analysis.  

For more information on instrument groups refer to “Instrument Groups with XML 
Commands” on page 84. 

The list of available parameters and their position in the XML is described below. 

 
<SchedulerCommand>  
 

<Template>false</Template> 

[‘true’ to create a template command in the Auto-Fills tab, ‘false’ to 
create an analysis] 

<Identifier>LIMS_ID</Identifier> 

[Sample Identifier generated by the LIMS] 

<LimsConnection>ValidLIMSConnectionName</LimsConnection> 

[With this command you refer to the LIMS connection configured in 
the LIMS tab of Sample Scheduler configuration. If the command 
does not contain a LIMS connection, the default LIMS connection is 
used. If the tag is blank or has an invalid LIMS connection specified, 
it will be not accepted and is deleted. 

<State>Waiting</State> 

[Waiting or Scheduled] 

<Project>OpenLabValidProject</Project> 

[Project defined in OpenLab, defines the path where CDS files will be 
stored. [If an instrument group is defined (see InstrumentMethods 
tag on page 77), this project is assigned to the first instrument 
group.] 
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<InstrumentGroupName>ValidInstrumentGroup 
</InstrumentGroupName> 

[With this command you refer to the instrument groups configured 
in Sample Scheduler configuration. The instrument group name 
refers to the name of the instrument group that is defined in Sample 
Scheduler configuration. See example XML file 
InstrumentGroup_Command.xml] 

<User>OpenLabValidUser</User> 

[User defined in OpenLab] 

<AlternativeProjects> 
  <Project>OpenLABValidProject2</Project> 
  <Project>OpenLABValidProject3</Project> 
</AlternativeProjects> 

[If an instrument group is defined (see InstrumentMethods tag on 
page 77), the alternative projects are assigned to the instruments at 
the corresponding positions. For example, the first alternative 
project will be assigned to the second instrument in the group.] 

<Replicates>3</Replicates> 

[Number of injections] 

<AnalysisVariable1>value 1</AnalysisVariable1> 
<AnalysisVariable2>value 2</AnalysisVariable2> 
<AnalysisVariable3>value 3</AnalysisVariable3> 
<AnalysisVariable4>value 4</AnalysisVariable4> 
<AnalysisVariable5>value 5</AnalysisVariable5>    
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<Tasks> 

 

<Task> 
<ResultName>ResultName1</ResultName> 

[CDS .rslt folder name] 

<InstrumentMethods> 
 <InstrumentMethod>  
  <InstrumentName>OpenLabValidInstrument1 
  </InstrumentName>  

 
  <AcquisitionMethodName>OpenLabValidMethod1.amx 
  </AcquisitionMethodName> 
 </InstrumentMethod> 

 
 <InstrumentMethod> 
  <InstrumentName>OpenLabValidInstrument2 
  </InstrumentName>  

 
  <AcquisitionMethodName>OpenLabValidMethod2.amx 
  </AcquisitionMethodName> 
 </InstrumentMethod> 
</InstrumentMethods> 

 

[If you define several InstrumentName/ AcquisitionMethodName 
couples, an instrument group Defined by LIMS is created for this 
analysis, and the user can choose the instrument. The first 
Instrument/method couple defined in this section will be applied to 
the analysis by default.] 
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<Towers>    

 

<Tower> 
 <LimsID1>LIMSID1</LimsID1> 
 <LimsID2>LIMSID2</LimsID2> 
 <LimsID3>LIMSID3</LimsID3> 

[Parameters supplied by the LIMS] 

 <ProcessingMethodName>OpenLabValidMethod1.pmx 
 </ProcessingMethodName> 
 
 <AlternativeProcessingMethodName> 
  <ProcessingMethodName>OpenLabValidMethod2.pmx 
  </ProcessingMethodName> 

 
  <ProcessingMethodName>OpenLabValidMethod3.pmx 
  </ProcessingMethodName> 
 </AlternativeProcessingMethodName> 

[If an instrument group is defined (see InstrumentMethods tag on 
page 77), the alternative processing methods are assigned to the 
instruments at the corresponding positions. For example, the first 
alternative processing method will be assigned to the second 
instrument in the group] 

 <SampleName>Sample1</SampleName> 

[CDS Sample  name, stored with the raw data] 
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 <InjectionSource>InjectionSourceName 
 </InjectionSource> 

[For an EZChrom System, the value of the InjectionSource tag 
should only be set to Front, Back, or Dual] 
 

 <AlternativeInjectionSource> 
  <InjectionSource>Dual</InjectionSource> 
  <InjectionSource>Dual2</InjectionSource> 
  <InjectionSource>Dual3</InjectionSource> 
 </AlternativeInjectionSource> 

 [If an instrument group is defined (see InstrumentMethods tag on 
page 77), the alternative injection sources are assigned to the 
instruments at the corresponding positions. For example, the first 
alternative injection source will be assigned to the second 
instrument in the group] 

 <SamplePrepMethodName> 
 OpenLabValidSamplePrepMethod1.smx 
 </SamplePrepMethodName> 

 

<SampleInfo> 
 

<Description> 
 <Line>long description in</Line> 
 <Line>several lines</Line> 
</Description> 
<Vial>1</Vial> 

[Autosampler location] 

<UseMethodInjectionVolume>False 
</UseMethodInjectionVolume> 

[‘true’ if the injection volume defined in the CDS Acquisition method 
is used to perform the analysis] 

<InjectionVolume>5</InjectionVolume> 

[Volume of sample to be injected. Mandatory if 
UseMethodInjectionVolume = False] 
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<SampleAmount>153.61</SampleAmount> 
<SampleAmountUnit>mg</SampleAmountUnit> 

 
<Multiplier1>2.369</Multiplier1> 
… 
<Multiplier5>2.369</Multiplier5> 

 
<Dilutor1>3.124</Dilutor1> 
… 
<Dilutor5>3.124</Dilutor5> 

 
<Target1>3.124</Target1> 
… 
<Target5>3.124</Target5> 
 

<CustomParameters> 
 

<SampleCustomParameter1> 
 <Name>CDSSampleCustomParameter</Name> 
 <Value>limsvalue3</Value> 
</SampleCustomParameter1> 
… 
<SampleCustomParameter20> 
 <Name>20thCDSSampleCustomParameter</Name> 
 <Value>limsvalue20</Value> 
</SampleCustomParameter20> 

 
</CustomParameters> 
</SampleInfo> 
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<Calibration> 
 

<SampleType>Sample</SampleType> 

[Sample type: Sample, Cal.Std., Blank, Double blank, QC check, Spike, 
Sys. Suit] 

<Level>1</Level> 

[Mandatory if SampleType = Cal.Std] 

<CalibrationRuntype>ClearAllCalibration 
</CalibrationRuntype> 

[Calibration runtype: ClearAllCalibration, ClearCalibrationAtLevel] 

</Calibration> 

<InternalStandard> 
 <InternalStandardAmount1>5 
 </InternalStandardAmount1> 
  
 <InternalStandardAmount5>5 
 </InternalStandardAmount5> 
 
 <InternalStandardAmountUnit>mg 
 </InternalStandardAmountUnit> 
</InternalStandard> 
 
</Tower> 
</Towers> 
</Task> 
</Tasks> 
</SchedulerCommand> 

 

An XML template is provided with the user documentation to help you build your 
own command: It is installed with the Sample Scheduler software under 
<Scheduler Install path>/Documentation/xml/ Advanced_Command.xml. 
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NOTE Ensure the instrument name, injection source and project are defined using the 
same spelling (including upper and lower case) as used in the Control Panel, 
otherwise the XML command will be considered as not valid, and sent to the 
<LIMS_Commands>/Trash folder. 

 

Multiple LIMS Connections 

Sample Scheduler provides the ability to connect to more than one LIMS with a 
single instance of the Sample Scheduler database. For backwards compatibility, 
Sample Scheduler is pre-configured with a default LIMS connection that allows 
existing installations to continue using Sample Scheduler, just as before, with a 
single LIMS connection after an upgrade. The default LIMS connection contains a 
minimum set of configuration parameters that you can change, if necessary.  

You can add multiple LIMS connections, specifying the associated parameters for 
each LIMS connection. To address an XML command to a specific LIMS 
connection, you must specify the name of the LIMS connection in the XML 
command. Analyses and sequences will be processed by the Sample Scheduler 
with the corresponding parameters configured for the LIMS connection. 

If a SQL query is specified for a LIMS database, the SQL command query is 
preferred for that LIMS connection. If XML commands are defined for the same 
LIMS connection, they are neglected and trashed. 

LIMS connections are set up in the LIMS tab of Sample Scheduler configuration. 
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Dual Simultaneous Injection with XML Commands 

For dual simultaneous injections the LIMS needs to write an XML file that has two 
Tower sections in a Task. The Injection Source must be the same for both towers 
and needs to support dual simultaneous injection. The string must match exactly 
the one provided by the acquisition client. Dual simultaneous injection is possible 
only if supported by the injection source. 

 

NOTE If dual simultaneous injection is not available in the acquisition client for the 
selected injection source, the device does not support dual simultaneous injections. 

 

The acquisition method must be the same for both towers. The processing 
methods can be different. 

The samples will be assigned to the injection source (front or back injector) in the 
same way as in acquisition client. In most cases the first line will be assigned to the 
Front injector, the 2nd line to the Back injector and so on, in alternating order. 

An XML template is provided with the user documentation to help you build your 
own dual simultaneous injection command: It is installed with the Sample 
Scheduler software under <Scheduler Install 
path>/Documentation/xml/DualInjection_Command.xml. 

Using Parameter ‘Use Method Injection Volume’ in XML Command 

If a default injection volume is defined in the acquisition method (only for 
instruments configured with an autosampler), it can be explicitly used to perform 
the acquisition when submitted by the Sample Scheduler.  

To use this option, you must define a ‘true’ value for the parameter 
<UseMethodInjectionVolume> in the XML command: 
 <UseMethodInjectionVolume>true</UseMethodInjectionVolume> 

The <InjectionVolume> </InjectionVolume> section is then optional in the XML as it 
is not used to perform the acquisition. 

Note that even if an injection volume is defined in the Acquisition method, another 
value can be defined in the XML. In this case, <UseMethodInjectionVolume> must 
be false in the XML. In addition, it is mandatory that you set a value for the Injection 
volume in the XML (strictly positive value). 
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Instrument Groups with XML Commands 

Instrument groups logically combine a set of alternative instruments that can do 
the same type of analysis. If instrument groups are configured, users can easily 
switch to another instrument for a specific analysis. The project, injection source, 
acquisition method, processing method can be defined for each instrument in the 
group and are automatically filled when the instrument is selected. 

One XML file can contain only one instrument group.  

The XML command can have the following functions: 
 Create an analysis using existing instrument groups  

The instrument groups are set up in Sample Scheduler configuration. The XML 
specifies the instrument group by its instrument group name, which is set in 
Sample Scheduler configuration. 

See example XML file under <Scheduler Install path>/Documentation/xml/ 
InstrumentGroup_Command.xml 
 

 Define a temporary instrument group for a given analysis 

This instrument group is not visible in Sample Scheduler configuration. In the 
Analysis table, the instrument group is referred to as Defined by LIMS. You can 
use the instrument group to switch to a different instrument as defined in the 
XML, but the group is not permanently stored in the Sample Scheduler 
database. Therefore, it cannot be used for another analysis, unless it is again 
completely defined in the respective XML. 

See example XML file under <Scheduler Install path>/Documentation/xml/ 
InstrumentGroupSpecifiedByLims_Command.xml 
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Add Multiple Instrument Lines to a Group 

For each parameter you can provide multiple entries. The structure depends on the 
parameter: 
 Instrument names and acquisition methods: 

They are always provided as a pair within an <InstrumentMethod> tag. 
 

NOTE To guarantee backwards compatibility, the <InstrumentMethod> tag structure is the 
same as in previous releases.  

 

 Projects:  

The second and all further tags are added within the <AlternativeProjects> tag. 
 Processing methods:  

The second and all further tags are added within the 
<AlternativeProcessingMethodName> tag. 

 Injection sources:  

The second and all further tags are added within the 
<AlternativeProcessingMethodName> tag. 

Always define the same number of alternative parameters. The first instrument line 
will contain the first project/instrument name/acquisition method/processing 
method/etc., the second line will contain the second parameter of each type, and so 
on. To use empty values, add empty tags. 

Analysis Variables in the XML Command 

Analysis variables (Analysis variable i) are variables created by the user in the 
Sample Scheduler configuration. They allow the user to display information in the 
Sample Scheduler client that is not provided by default by the Sample Scheduler: for 
example, the laboratory name where the instrument is located. 

The user can assign a value to these variables either in the XML command or in the 
Sample Scheduler client.  

These variables can also be part of the result name or sample name. 

Up to five analysis variables can be defined per analysis. 

Analysis variable values are displayed in the Sample Scheduler client in the Analysis 
Table, in Analysis variable i columns. 

 

NOTE The values of these variables are not transferred to the CDS and cannot be 
displayed or reported in the CDS. They only exist in the Sample Scheduler database. 
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Sample Custom Parameters in the XML Command 

Sample custom parameters (Sample custom parameter i) are variables created by 
the user in OpenLab CDS or EZChrom on project level, or alternatively just in the 
Sample Scheduler. They allow the user to display and enter information in the 
Sample Scheduler client that may be transferred to and used by the CDS, but only if 
they were previously defined in the CDS settings for a given project. 

The user can assign a value to these variables either in the XML command or in the 
Sample Scheduler client.  

These variables can be part of the result name for single runs, and of the sample 
name. 

Up to 20 sample custom parameters can be defined per analysis. 

Sample custom parameters values are displayed in the Sample Scheduler client in 
the Analysis Table, in Sample custom parameter i columns. 

Use Tokens in the XML Command 

It is possible to use the same predefined identifiers (tokens) as the ones proposed 
by the Single Sample or Sequence in the CDS Acquisition to define the result name 
and the sample name in the XML command. 

It is also possible to use Scheduler specific variables. 
 

NOTE Only Sample Scheduler tokens are applied, not CDS tokens. 
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Table 11 Tokens 

Parameter Token 

SampleName Acq. Method <AMX> 
Instrument name <I> 
Local date & time <D> 
Custom local date & time <CD> 
Proc Method <PMX> 
Short local date & time <DS> 
Username <U> 
Vial <V> 
Identifier <ID> 
Analysis variable i [i=1 to 5] <A1> to <A5> 
LIMS IDi [i=1 to 3] <LID1> to <LID3> 
Sequence name <SEQ> (Sequence only) 

Result Name (single run) Acq. Method <AMX> 
Instrument name <I> 
Local date & time <D> 
Custom local date & time <CD> 
Proc. Method <PMX> 
Sample name < S> 
Short local date & time <DS> 
Username <U> 
Vial <V> 
Identifier <ID> 
Analysis variable i [i=1 to 5] <A1> to <A5> 
LIMS ID I [i = 1 to 3] <LID1> to <LID3> 

Result Name (sequences and dual 
simultaneous injections) 

Instrument name <I> 
Local date & time <D> 
Custom local date & time <CD> 
Short local date & time <DS> 
Username <U> 
Sequence name <SEQ> 

Result Path Instrument name <I> 
Local date & time <D> 
Custom local date & time <CD> 
Short local date & time <DS> 
Username <U> 
Analysis variable i [i=1 to 5] <A1> to <A5> 
Sequence name <SEQ> 
 
Invalid characters that are not allowed in Databackends 
are removed from the resolved path 

DataFile Sample name <S> 
Acq. Method <AMX> 
Instrument name <I> 
Local date & time <D> 
Proc Method <PMX> 
Short local date & time <DS> 
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Table 11 Tokens 

Username <U> 
Vial <V> 

If using Sample Name or Sequence Name as tokens, ensure that these names do 
not contain invalid characters, such as ?/|<>*:". 

OpenLab CDS or EZChrom predefined name types contain < > symbols. Those 
symbols have a meaning in XML language and therefore cannot be expressed in 
this way in the Scheduler XML command. 

The syntax to use in XML command is: 
 &lt;   to replace < 
 &gt;   to replace > 

 

For example: 
  <SampleName>&lt;AMX&gt; </SampleName>  

where SampleName is the Acquisition Method name 

 
  <ResultName>&lt;ID&gt;_ &lt;D&gt;_ &lt;E1&gt;  </ResultName>  

where Result name is the Id_Date&Time_Analysis variable 1 

Priority Rules 

The parameter values used by the CDS to perform an analysis (project, instrument, 
user, vial, etc.) can be defined in three ways in the Sample Scheduler: 
 XML command: all parameters, 
 Sample Scheduler configuration: user, project, result name, sample name, initial 

state (default values used to perform the analysis when no value is defined in 
the command),  

 Sample Scheduler client: all parameters can be edited. 
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To manage possible priority conflicts, the following priority rules have been set:  

Table 12 Priority rules 

Parameter Priority rules 

Sample name, Result name, User, Project 1. XML commands 
2. Sample Scheduler configuration default values 

All parameters that are editable in Sample 
Scheduler client 

1. Values as edited in the Sample Scheduler client 
2. XML commands 
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XML Command Creation 

Some example XML commands are available in the 
<SampleScheduler>/Documentation folder. They allow you to generate the XML 
commands properly in your LIMS. 
 Minimal_Command.xml: minimal structure of the XML in the case no 

mandatory parameter has been added in the Sample Scheduler configuration > 
System Configuration window (only Identifier and Sample name are checked). 

 Basic_command.xml: minimal required information to perform an acquisition. 
The OpenLab default user, OpenLab default project, Default sample name and 
Default result name must be assigned a value in the Sample Scheduler 
configuration to use such a command. 

 Advanced_command.xml: structure containing all the possible parameters 
 SampleCustomParameters_ command.xml: structure showing how to use 

Sample Custom Parameters with Sample Scheduler.  
 DualInjection_ command.xml: structure showing how to create dual injection 

commands. 
 Holding_Command.xml: structure to use in case of commands to merge (refer 

to the Sample Scheduler online help to learn more on the merge option). 
 Additional templates: structure of the XML to set single injection source and 

dual injection source instruments with or without calibration. These commands 
contain all the parameters required by the CDS to perform an acquisition. 

 UnknownSample_Single_InjectionSource_Command.xml: Acquisition of an 
Unknown sample in External standard calibration runtype, on a single injection 
source instrument.   

 CalibrationSample_Single_InjectionSource_Command.xml: Acquisition of a 
Standard sample in internal standard calibration runtype, on a single injection 
source instrument. 

 InstrumentGroup_Command.xml: Acquisition of an analysis using the 
instrument group defined in Sample Scheduler configuration.  

 InstrumentGroupSpecifiedByLims_Command: Structure of the XML to define 
an instrument group for a given analysis. 
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XML Action 

The Scheduler can manage XML files that are not intended to create an analysis, 
but to perform an action. 

Those ‘Action commands’ do not match the classical XML command scheme, but a 
simplified scheme.  

Two Action commands are proposed by default: 
 Cancel command: to delete an analysis or sequence and that is stored in the 

Scheduler database and that has not yet been started (i.e., in Waiting or 
Scheduled state only). The analysis or sequence to delete is identified by its 
Identifier.  

 
  <SchedulerAction> 
   <Identifier>Analysis_Or_Sequence_To_Delete</Identifier> 
   <Type>Delete</Type> 
   <LimsConnection>ValidLIMSConnectionName<LimsConnection> 
  </SchedulerAction> 

 

The Cancel command is sent into the <LIMS_Commands> folder. The Scheduler 
handles it and deletes the corresponding analysis or sequence from the Scheduler 
database. The analysis or sequence is removed from the Scheduler interface. The 
Cancel command does not generate an analysis or sequence and is never 
displayed in the Scheduler client. 

The LIMS connection is used to identify the corresponding Processed command 
folder where the XML file will be moved to after successful execution. If no LIMS 
connection is specified in the XML file, the Processed command folder of the 
default LIMS connection is used. Commands that have an invalid LIMS connection 
specified are not accepted and are deleted. 

You can use the Cancel_Analysis_Command.xml template located in the 
<SampleScheduler for OpenLab>/Documentation folder to build your own 
command. The XML scheme SchedulerAction.xsd, which is provided by the setup 
in the same folder, is used by the Sample Scheduler LIMS agent to check the 
command validity before its entry in the database. 

 
 Create sequence: to group a selection of analyses, stored in the Sample 

Scheduler database, into a sequence. 
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  <SchedulerCreateSequenceAction> 
   <LimsConnection>ValidLIMSConnectionName</LimsConnection> 
   <SequenceName>MySequence</SequenceName> 
   <SequenceState>Scheduled</SequenceState> 
   <User>Analyst</User> 
   <Identifiers> 
    <Identifier>MySequenceLine-123</Identifier> 
    <Identifier>MySequenceLine-456</Identifier> 
    <Identifier>MySequenceLine-789</Identifier> 
    <Identifier>MySequenceLine-555</Identifier> 
    <Identifier>MySequenceLine-999</Identifier> 
   </Identifiers> 
  </SchedulerCreateSequenceAction> 
 

You must define: 
 A LIMS connection (not mandatory). If the XML command does not contain 

the tag, the default LIMS connection is used. If the tag is blank, the 
command is sent to the trash folder.  

 A sequence name (not mandatory). 
 The initial sequence state. If not defined, the default state defined in the 

Sample Scheduler configuration is used. 
 The user who is assigned to the sequence. If not defined, the acquisition 

user defined in the Sample Scheduler configuration is used. 
 The list of analyses to group, identified by their identifier. The sequence is 

created only if: 
 All analyses exist in the Sample Scheduler database.  
 All analyses are assigned to the same instrument, project, injection source, 

and LIMS connection. 
 All analyses are in Waiting, Incomplete or Waiting on error state. 
 Otherwise the sequence is not created, and the XML file is sent to the trash 

folder. 

 

You can use the Create_Sequence_Command.xml template located in the 
<SampleScheduler for OpenLab>/Documentation folder to build your own 
command. The XML scheme SchedulerCreateSequenceAction.xsd, which is 
provided by the setup in the same folder, is used by the Sample Scheduler LIMS 
agent to check the command validity before its entry in the database. 
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Sample Scheduler XML File Generator 

The XML file generator enables the administrator to generate test XML commands 
for setting up the Sample Scheduler system. This tool makes it easy to create valid 
XML commands with the desired parameters that can be processed by LIMS.  

The XML tool is located on the installation media in the folder Support>Xml_tool. 

Working with the XML file generator 

Using the XML file generator, you can create single or multiple analyses. You can 
also create a sequence from the analyses.  

 
Mandatory parameters are marked with an asterisk and require entry of a value: 
 Scheduler Identifier 

For multiple analyses the entered value is the start value. The ID of the 
following analysis is incremented by one.  

 LIMS identifier1  

For multiple analyses the entered value is the start value. The ID of the 
following analysis is incremented by one. 

 Project  
 Instrument 
 Acquisition method  

An extension is not required. If no extension is given, the extension .amx is 
automatically appended in the XML. Entries for the extensions .amx or .met are 
accepted for XML command creation. 

 Injection source 
 Vial position 

 
The optional parameters do not require value entry: 
 Sequence name 

The default name is sequence.  
 Sample Name 

For multiple analyses, select Use sample name start counter. The entered 
value is the start value. The value of the following analysis is incremented by 
one. 

 State  

The state can be set to Holding, Scheduled, or Waiting. 
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 Processing method  

An extension is not required. If no extension is given, the extension .pmx is 
automatically appended in the XML. Entries for the extension .pmx are 
accepted for XML creation. For EZChrom, this parameter is not provided.  

 Sample Type 
 Set injection volume  

If selected, UseMethodInjVol=false. 
 User  
 Injection per sample 

The XML files are stored in a separate folder. This folder is created when generating 
the XML file. Sequence XML files are stored in a subfolder that is automatically 
created by the XML tool. The name of the subfolder corresponds to the name of the 
sequence. If a folder with this name already exists, an increment is automatically 
appended. 

Command Collected via SQL Query 

This chapter describes how Sample Scheduler must be configured to allow the 
collection of analysis orders directly in the LIMS database. 

The Sample Scheduler provides a generic tool to gather analysis orders from the 
LIMS database (that handles SQL Queries). As all LIMS databases are different, it is 
up to your database system administrator to configure the parameters detailed 
below to fit your LIMS database structure. 

The configuration is done in the LIMS tab of the Home ribbon tab (see also the 
LIMS section in the Sample Scheduler online help).  

Both analyses and sequences can be submitted to the Sample Scheduler via SQL 
query. They are automatically assigned the LIMS connection from the configured 
LIMS database. 
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Configure the Connection String 

The connection string is a chain of characters containing the required information 
to establish a connection between the Sample Scheduler and your LIMS database. 
This chain contains the provider, the user/password, etc. 

 
 Examples for an MS SQL Server:  

SQL Server and Windows Authentication mode: 
  Server=ComputerName\DB_Instance Name;  
  Database=DatabaseName;  
  Password=XXX; User ID=Database_User; 

Windows Authentication mode: 
  Server= ComputerName\DB_Instance Name\SQLEXPRESS;  
  Database= DatabaseName;trusted_connection=yes; 

 
 Example for an Oracle Server: 

  Data Source= (DESCRIPTION = 
  (ADDRESS = (PROTOCOL = TCP)(HOST = XXXXXX)(PORT = XXXX)) 
  (ADDRESS = (PROTOCOL = TCP)(HOST = XXXXXX)(PORT = XXXX)) 
  (CONNECT_DATA = 
  (SDU = 8192) 
  (TDU = 8192) 
  (SERVER = DEDICATED) 
  (SERVICE_NAME = XXXX) 
  ) 
  );user id=XXXXXX;password=XXXXX; 

 

The database user must have ‘Select’ and ‘Update’ rights on the LIMS database. 

To know which connection string is required according to your database, refer to 
the http://www.connectionstrings.com/ site. 

To test your connection string, click Test connection. 
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Write an SQL Query 

The LIMS query must be based on the structure of data expected by the Sample 
Scheduler. 
 For an analysis on a Single Injection Source instrument, the LIMS Query returns 

a single entry to the Sample Scheduler, allowing the creation of the Single 
Injection Source analysis. 

 For an analysis on a dual injection source instrument, the LIMS Query returns 
two entries to the Sample Scheduler, allowing the creation of the dual injection 
source analysis. 

 For a sequence, the LIMS Query returns the <number of sequence lines> entries 
for the specified sequence to the Sample Scheduler, allowing the creation of the 
sequence. 

The LIMS Query result must match the following structure and syntax: 
 

Table 13 SQL query 

Sample Scheduler 
parameter 

Value Type Description 

Identifier n/a Varchar 
(not null, unique) 

The sample identifier. Must 
be unique. It is used to notify 
the LIMS that a command 
has been handled, to avoid it 
to be considered a second 
time. 

Barcode n/a Varchar (null accepted) Gives the option to identify a 
sample by scanning a 
barcode. 
Specific to individual 
analyses and analyses within 
a sequence, but not available 
for an entire sequence. 

Template n/a Boolean 
(null accepted) 

Specifies if this experiment 
should be used as a template 
for the  
auto-fill feature. Make sure 
that the template identifiers 
do not collide with analysis 
identifiers that will be 
handled by the system. 

LimsIDi, [ i=1 to 3] n/a Varchar 
(null accepted) 

Values supplied by the LIMS 
for usage in the CDS. 

SampleName n/a Varchar 
(not null) 

The sample name. 
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Table 13 SQL query 

Sample Scheduler 
parameter 

Value Type Description 

State 1= Scheduled 
3=Waiting 
10=Holding 

Integer 
(null accepted) 

The initial state assigned to 
the analysis. 
If no value, the default state 
defined in the Sample 
Scheduler configuration is 
used. 

InstrumentGroupName   n/a Varchar Name of instrument group 

SequenceId n/a Integer  
(null accepted) 

The sequence id assigned to 
the analysis. Analyses with 
the same sequence id belong 
to the same sequence. If no 
value is assigned, the 
analysis does not belong to a 
sequence. 

SequenceName n/a Varchar 
(null accepted) 

The sequence name 

SequencePosition n/a Integer  
(null accepted) 

The sequence position of the 
analysis in the sequence. The 
first sequence position of a 
sequence begins with 1. 

ProjectName n/a Varchar 
(null accepted) 

CDS project name 

UserName n/a Varchar 
(null accepted) 

CDS user name 

Replicates n/a Integer 
(null accepted,  
default value 1) 

Sample Scheduler parameter. 
If greater than one, the 
analysis will be replicated n 
times with the same 
parameters as specified in 
the SML/SQL result. 

AnalysisVariableN,  
 [N=1 to 5] 

n/a Varchar 
(null accepted) 

Custom parameters. 

ResultName n/a Varchar 
(null accepted) 

The name of the result files 
to be generated by the CDS. 
If no value is specified, the 
default result name defined 
in the Sample Scheduler 
configuration is used. 
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Table 13 SQL query 

Sample Scheduler 
parameter 

Value Type Description 

ResultPath n/a Varchar 
(null accepted) 

Path where the CDS results 
are stored, including 
subfolders separated by 
slashes. 
If no value is specified, the 
default result path defined in 
the Sample Scheduler 
configuration is used. 

InstrumentName n/a Varchar 
(null accepted) 

CDS instrument name. 

AcquisitionMethodName n/a Varchar 
(null accepted) 

Method used to perform the 
analysis in the CDS. 

ProcessingMethodName n/a Varchar 
(null accepted) 

Method used to process the 
analysis in the CDS. 

AlternativeInstrumentsMetho
ds 

pattern like 
"inst1/meth1| 
inst2/meth2| 
inst3/meth3" 

Varchar 
(null accepted) 

Combination of instrument 
and acquisition method that 
can be used to perform the 
analysis instead of the 
nominal InstrumentName / 
AcquisitionMethodName 
couple. 
No limit in the number of 
alternative 
instrument/method couples. 

*InjectionSource n/a Varchar 
(null accepted) 

Injection source of the 
autosampler used to perform 
the analysis 

*InjectionLocation 0=Front injection 
1=Back injection 

Integer 
(null accepted) 

Location of the injector, for 
dual simultaneous injections. 
Is one set to a valid value and 
the other is null or another 
incorrect value, the valid 
value is used to set the order. 
Are both set to null or another 
not valid value then the order 
will not be changed. Are both 
set to the same valid value an 
error occurs. 

*SampleDescription n/a Varchar 
(null accepted) 

Description of the sample. 

Vial n/a Varchar 
(null accepted) 

The vial position where the 
sample is taken. 
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Table 13 SQL query 

Sample Scheduler 
parameter 

Value Type Description 

*UseMethodInjection 
Volume 

n/a Boolean 
(null accepted) 

The injection volume defined 
in the acquisition method 
that is used to perform the 
analysis. 

*InjectionVolume n/a Float 
(null accepted) 

Volume of the sample 
injected. 

*SampleAmount n/a Float 
(null accepted) 

Amount of sample. Used to 
perform quantitation in the 
CDS. 

*SampleAmountUnit n/a Varchar 
(null accepted) 

Unit of the sample amount. 

*SamplePrepMethod n/a Varchar 
(null accepted) 

Sample prep method used by 
the CDS. 

*TargetN, [N=1 to 5] n/a Varchar 
(null accepted) 

The target fields can be used 
to specify the target masses 
or formulas for compounds 
that are analyzed using an 
MS or LC/MS sample purity 
method. 

*MultiplierN, [N=1 to 5] n/a Float  
(null accepted) 

Used to perform quantitation 
in the CDS. 

*SampleCustomParameterN
Name [N=1 to 20] 

n/a Varchar 
(null accepted) 

Used to submit Sample 
Custom Parameters to the 
CDS. 

*SampleCustomParameterN
Value [N=1 to 20] 

n/a Varchar 
(null accepted) 

The value that gets 
submitted to the CDS under 
the Sample Custom 
Parameter specified in the 
SampleCustomParameterNa
me. 
This value needs to be valid 
according to the type that 
was specified for the Sample 
Custom Parameter in 
OpenLab CDS. (E.g.: a value 
for a Custom Parameter with 
type Date has to be 
convertible to a date) 

DilutorN, [N=1 to 5] n/a Float 
(null accepted) 

Used to perform quantitation 
in the CDS. 
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Table 13 SQL query 

Sample Scheduler 
parameter 

Value Type Description 

*SampleType 0=Sample,  
1=Cal.Std. 
2=Blank 
3=DoubleBlank 
4=QCCheck 
5=Spike 
6=Sys.Suit 

Integer 
(null accepted) 

Define if the sample is 
analyzed as a Sample or 
another type. Default is 
Sample. 

*InjectionsPerSample n/a Integer 
(null accepted) 

Define how often the sample 
should be injected by the 
CDS. 

*Level n/a Integer  
(null accepted) 

Calibration level defined in 
the processing method. 

*CalibrationRuntype 0=ClearAllCalibration 
1=ClearCalibrationAtLevel 

Integer 
(null accepted) 

Define the way previous 
calibration points are 
considered when a new 
standard point is added to 
the calibration curve 

*InternalStandardAmountN, 
[N=1 to 5] 

n/a Float 
(null accepted) 

Amount of internal standard 
in the sample. Used to 
perform quantitation in the 
CDS. 

*InternalStandardUnit n/a Varchar 
(null accepted) 

Unit of the internal standard 
amount. 

* Parameters to be defined by Injection source. 
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All the commands defined into the LIMS database must contain at least the 
following parameters to be considered valid by the Sample Scheduler: 
 Identifier 
 Sample name 
 The list of mandatory parameters defined in the Home/Commands tab, 

Mandatory column. 

SQL Query Examples  

With the Sample Scheduler documentation comes an SQL connection example that 
can be used to understand how to setup a LIMS connection via SQL. The example 
scripts are written for a Microsoft SQL database and are installed under: 

<Scheduler Install path>/Documentation/sql. 

The queries and the database show how to get all available parameters from a 
simulated LIMS into the Scheduler. 

Find below a simple example of queries built for an MS SQL Server LIMS database 
that could be handled by the Sample Scheduler. 

Figure 17 shows an example of a LIMS database (LIMS_DB) consisting of two 
tables: 
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  Figure 17 LIMS database 
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dbo.command table: 

Lists all parameters to be defined by analysis 

 

dbo.tower_parameters table: 

Lists all parameters to be defined by Injection source. 

The scheduledStatus parameter has been added to assign a flag to the command: 

0: already handled by the Sample Scheduler,  

1: properly handled, 2: handled but invalid. 

 

In the case of an analysis to be performed on a single Injection source instrument:  

One entry in the dbo.commands table 

One entry in the dbo.tower_parameters table. 

 

In the case of an analysis to be performed on a dual injection source instrument:  

One entry in the dbo.commands table 

Two entries in the dbo.tower_parameters table. 

 

In the case of a sequence with analyses to be performed on a single injection 
source instrument: 

<Number of sequence lines> entries in the dbo.commands table 

<Number of sequence lines> entries in the dbo.tower_parameters table. 

 

In the case of a sequence with analyses to be performed on a dual injection source 
instrument: 

<Number of sequence lines> entries in the dbo.commands table 

Twice the <Number of sequence lines> entries in the dbo.tower_parameters table. 

 

NOTE Only some of the parameters that can be defined in an analysis are proposed in this 
example, but you can define all the parameters listed in the table above. 
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The following example handles the case where the LIMS database (LIMS_DB) 
provides parameters with names different than the ones expected by the Sample 
Scheduler (for example, ‘chromatograph’ in the LIMS database corresponds to 
‘InstrumentName’ in the Sample Scheduler database). It is up to the LIMS query to 
link the LIMS parameters and the corresponding Sample Scheduler parameters: 
chromatograph as InstrumentName. 

In this example, we also manage the notification back to the LIMS database, to 
inform that a defined command has been handled (with success or not), to avoid 
handling the same command several times. It is the role of the LIMS notification: 
Valid command and LIMS notification: invalid command queries. 

SQL Query 

SELECT  
c.sampleName as SampleName,  
c.analysisId as Identifier, 
c.sequenceId as SequenceId, 
c.sequencePosition as SequencePosition,  
CASE  
  WHEN analysisState='Scheduled' THEN 1  
  WHEN analysisState='Waiting' THEN 3  
  WHEN analysisState='Holding' THEN 10  
  ELSE NULL  
END as [State],  
c.laboUser as [UserName],  
c.openLabProject as ProjectName,  
c.chromatograph as InstrumentName,  
c.CDSMethod as AcquisitionMethodName,  
c.resultFolder as ResultName,  
t.analysis_tower as InjectionSource,  
t.analysis_sample_mass as SampleAmount,  
t.analysis_dilutor as Dilutor1,  
c.Variable as AnalysisVariable1,  
CAST(t.analysis_multiplier as float) as Multiplier1,  
t.analysis_level as Level, 
t.analysis_vial as Vial,  
t.analysis_injection_volume as InjectionVolume,  
t.analysis_tower as InjectionSource, 
'Plantidentifier' as SampleCustomParameter1Name, 
t.customer_custom_field1 as SampleCustomParameter1Value 
CASE  
  WHEN t.analysis_sample_type='Sample' THEN 0  
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  WHEN t.analysis_sample_type='Calib' THEN 1 
  ELSE NULL 
END as SampleType, 
c.alternative as AlternativeInstrumentsMethods 
FROM [LIMS_DB].[dbo].[command] c LEFT JOIN 
[LIMS_DB].[dbo].[tower_parameters] t ON (c.analysisId = 
t.command_analysisId) 
WHERE scheduledStatus = 0; 

The Sample Scheduler manages only commands with scheduledStatus = 0. 

Once the Sample Scheduler has handled a command, it sends a value back to the 
LIMS database/scheduledStatus parameter. In this example: 
 scheduledStatus=1 if the command has been properly handled (valid 

command), 
 scheduledStatus=2 if the command was invalid (not transformed into an 

analysis in the Sample Scheduler database). 

LIMS Notification 

LIMS Notification: Valid Command (example for SQL server) 

UPDATE LIMS_DB.[dbo].[command] SET scheduledStatus = 1 WHERE analysisId = 
@Identifier; 

LIMS Notification: Invalid Command (example for SQL server) 

UPDATE LIMS_DB.[dbo].[command] SET scheduledStatus = 2 WHERE analysisId = 
@Identifier; 

Only the parameter Identifier can be provided by the Sample Scheduler for both the 
valid and the invalid command. 

In the notification query, the variable name depends on the used database 
connection provider. For example, as variable name Microsoft SQL-Client expects 
@Identifier and Oracle-Client expects :Identifier. For an exact definition of the 
notation, see the documentation of the database connection provider that you use 
to access the LIMS database. 
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Dual Simultaneous Injection via SQL Query 

To create dual simultaneous injection commands, the results from the command 
creation query need to fulfill the following requirements: 
 For both lines of the dual injection command, the identifier must be the same. 

This will instruct Sample Scheduler to create a dual injection sample analysis. 
For the parameters that are common to both injectors, it will use the values 
specified for the front injector (first line). 

To ensure that the correct parameters are assigned to the front and back injector, 
the command creation query needs to consider the order of the analyses submitted 
by the LIMS. This can be achieved by adding a "sort by clause" statement. For 
example, if the LIMS always sends a higher value for the vial location of the back 
injection the analyses could be sorted by vial location. Alternatively, you may use an 
analysis or instrument custom parameter to sort by. Another way to determine the 
order of the analyses is to define the Injection Location field for each of the towers. 
Lines set to 0 refer to the front position, lines set to 1 refer to the back position. The 
injection source must be the same for both front and back injector, and it needs to 
support dual simultaneous injection. 

Sequence Creation via SQL Query 

To create a sequence via SQL query, the results from the command creation query 
need to fulfill the following requirements: 
 For all the analyses belonging to the same sequence, the sequence id must be 

the same. 
 The first analysis of the sequence gets the first sequence position (sequence 

position = 1). 
 For the other sequence lines, the sequence position must be incremented 

consecutively by one. 
 Parameters that are common to a sequence must be the same for all sequence 

lines.  
 

It is not possible to append sequence lines via SQL query to an already existing 
sequence in the Sample Scheduler database. 
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11 Command Validity Process 

When a command is generated by the LIMS, it is handled by the Sample Scheduler 
(Sample Scheduler LIMS agent). The following validity control process is applied: 

 
Figure 18 Validity control process 
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1 The command matches the expected syntax format.  
 The XML command must match the XML scheme (XSD). This scheme 

checks the XML syntax, the XML structure, the type (integer, boolean, etc.) 
and the properties of each parameter (For example, the sample type can 
only be Sample, Cal.Std., etc.; the injection volume must be a number; etc.). 
The SchedulerXmlCommand.xsd file is provided in the Sample Scheduler 
for OpenLab/Documentation folder. 

 The commands collected via SQL Query must also respect the expected 
structure, and contain parameters respecting the rules defined in the query 
(valid parameter name, type, properties, etc.). 

2 The command contains the mandatory parameters defined in the 
Command/Mandatory tab. If Project, User, Sample Name, Result Name or 
State parameters have no value, they are assigned the default values defined in 
the Sample Scheduler configuration, System Configuration tab. 

3 The command satisfies the business rules (if Dilutor, Multiplier, Sample 
amount equal 0, they are assigned the value 1). The server in the OpenLab 
system checks if the Project, User, Instrument, and Acquisition methods exist. 

4 If the command does not satisfy at least one of the steps 1 to 3, it is sent to the 
<LIMS Commands>/trash folder. No analysis is generated. 

5 If steps 1 to 3 are satisfied, an analysis is generated in the Scheduler database. 
6 Steps 1 to 3 are satisfied if: 

 all parameters needed by the CDS are defined, 
 the analysis is set to either the Waiting or the Scheduled state.  

7 If at least one of these parameters is missing, the analysis is assigned the 
Incomplete state. 

8 Mandatory parameters in the CDS: Instrument, Injection source, Project, 
Acquisition method, Result file name, Vial, Injection volume. 
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If the Auto-fill command option is used, the validity process is modified as follows: 

 
Figure 19 Auto-fill command validity process 

1 The command matches the expected syntax, format.  
 The XML command must match the XML scheme (XSD). This scheme 

checks the XML syntax, the XML structure, the type (integer, boolean, etc.) 
and the properties of each parameter (for example, the sample type can 
only be Sample, Cal.Std., etc.; the injection volume must a number, and so 
on). The SchedulerXmlCommand.xsd file is provided in the Sample 
Scheduler for OpenLab/Documentation folder. 

 The commands collected via SQL Query must also respect the expected 
structure, and contain parameters respecting the rules defined in the query 
(valid parameter name, type, properties, etc.). 

2 A value is assigned to all the Auto-fill trigger parameters, and a template 
analysis exists in the Auto-fill command table: the command is completed 
according to the template analysis. 

3 The command contains the mandatory parameters defined in the 
Command/Mandatory tab. If Project, User, Sample name, Result file name, 
and/or State parameters have no value after completion with template analysis, 
they are assigned the default values defined in the Sample Scheduler 
configuration, System Configuration tab. 

4 The command satisfies the business rules (if Dilutor, Multiplier, Internal 
standard amount, or Sample amount equal 0, they are assigned the value 1). 
The server in the OpenLab system checks if the Project, User, Instrument, and 
Acquisition methods exist.  

5 If the command does not satisfy at least one of the steps 1, 3 or 4, it is sent to 
the <LIMS Commands>/trash folder. No analysis is generated. 

6 If steps 1, 3 and 4 are satisfied, an analysis is generated in the Scheduler 
database. 
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7 Steps 1, 3 and 4 are satisfied: If all parameters needed by the CDS to perform 
an acquisition are defined, the analysis is assigned either the Waiting or the 
Scheduled state. If at least one of these parameters is missing, the analysis is 
assigned the Incomplete state. 

 

NOTE If a wrong ticket is defined, for example the credentials correspond to an OpenLab 
user that cannot use the instrument, the Sample Scheduler will not be able to 
perform an analysis, as the Agilent Sample Scheduler agent service will not start. 
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12 Activity Logs 
 

Sample Scheduler offers the possibility to log your activities in the software. Once 
the audit trail is enabled (Sample Scheduler configuration > System Configuration), 
all the actions performed by Sample Scheduler for OpenLab are traced in the 
System Activity Log of the Control Panel (under Administration). Those logs can 
be useful to understand the reason and to perform the appropriate action to correct 
a potential problem. For more information on how to search, filter, export, print or 
refresh the activity log, refer to the Control Panel online help (search for “System 
Activity Logs”). 

 

NOTE Once the audit trail has been enabled, you can no longer disable it.  

If an error occurs, refer to the “Troubleshooting” section on page 150, to see if it 
deals with the issue you encountered. If not, send the above log files to your 
Technical Support.  

Some problems may be induced by a database connection issue, so be sure to 
check the database connectivity in case of doubt. 
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13 Maintenance Operations 

Reconfigure Sample Scheduler Database 

If the Sample Scheduler database access has been modified (after the Sample 
Scheduler has been installed and configured), you must reconfigure the Sample 
Scheduler database access parameters. 

This can happen in the following situations: 
 Change of database computer/Instance 
 Change of the authentication mode (Windows authentication or SQL 

authentication) 
 Change of user credentials (login and/or password). 

 
1 To reconfigure the database access, ensure that no analysis is running. 
2 Start the <Sample Scheduler for OpenLab>\bin\ 

Agilent.Scheduler.Database.Access.reconfiguration.exe installed together 
with the Scheduler Database. 

  
   Figure 20 Database Access Reconfiguration 
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3 Update the values of the parameters: 

 Define the Database type (SQL server or OLDR) 
 Provide the Server Instance name 
 Authentication mode (in case of SQL Server instance) with credential (in 

case SQL Authentication) 
 Password to access the OLDR (created during the installation of Sample 

Scheduler on the server) 
4 Then click Test Database Connection. If the parameters are valid, you can save 

the new parameters. The connection parameters are updated in the registry. 

Restart the Agilent Sample Scheduler LIMS agent service and all Agilent Sample 
Scheduler agent services (Home/Deployment). 

Change the Sample Scheduler Agent assigned to an 
Instrument 

In the Instrument management tab of Sample Scheduler configuration: 
1 Assign the new Sample Scheduler agent computer name to the instrument, 

click OK. 
2 Save. 

In the Deployment window: 
3 Restart the two Sample Scheduler agent services: the old one and the new one 

(ensure no analysis is currently running on the instruments managed by the 
Sample Scheduler agents). 

4 Restart the Sample Scheduler LIMS agent. 
5 Click Refresh. 
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Rename a Computer that is the Host of a Sample 
Scheduler Agent 

1 Rename the computer. 
2 If this computer is an OpenLab AIC, register the AIC. 

 

No action is needed in Sample Scheduler; the new computer name is automatically 
updated in both the Home/Instrument management and Home/Deployment tabs. 
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Rename the Instrument in the Control Panel 

In the Instrument Management window: 
1 Assign the Sample Scheduler agent computer name to the instrument and 

click OK. 
2 Save. 

 

In the Home>Deployment tab:  
3 Restart the Sample Scheduler agent service (ensure no analysis is currently 

running on the instruments managed by this Sample Scheduler agent). 
4 Restart the Sample Scheduler LIMS agent.  
5 Click Refresh. 

Add an Instrument in the Control Panel 

1 Create and configure the new instrument in the Control Panel. 
2 Start a new session of Sample Scheduler configuration 

In the Instrument management window: 
3 Assign the Sample Scheduler agent computer name to the instrument and 

click OK. 
4 Save. 

In the Deployment window: 
5 Restart the Sample Scheduler agent service assigned to the new instrument 

(ensure no analysis is currently running on the instruments managed by this 
Sample Scheduler agent). 

6 Wait until a Sample Scheduler acquisition agent is created by the instrument 
managed by the Sample Scheduler agent (especially for the new instrument). 

7 Restart the Scheduler LIMS agent. 
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Delete an Instrument in the Control Panel 

1 Delete the instrument in the Control Panel. 
2 Start a new session of Sample Scheduler configuration 

In the Deployment window: 
3 Restart the Sample Scheduler agent service that managed the deleted 

instrument. 
4 Restart the Scheduler LIMS agent.  
5 Click Refresh. 

In the Instrument management window, ensure that the instrument name is listed 
no more. 

Deploy a Reconfigured Instrument in Sample 
Scheduler 

1 Reconfigure the instrument in the Control Panel. 
2 Start a new session of Sample Scheduler configuration. 

In the Deployment window: 
3 Restart the Sample Scheduler agent service assigned to the instrument (ensure 

no analysis is currently running on the instruments managed by this Sample 
Scheduler agent). 

4 Wait until a Sample Scheduler acquisition agent is created by the instrument 
managed by the Sample Scheduler agent. 

5 Restart the Scheduler LIMS agent. 

Change Project Settings in the Control Panel 

If you change the project settings in the Control Panel (for example, enabling the 
audit trail, allowing to prompt for a reason), you must restart the Sample Scheduler 
agent in Sample Scheduler configuration (Deployment tab) for the changes to be 
applied. 
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Adding an AIC after Activation 

After installing Sample Scheduler on an additional OpenLab AIC, you have to 
provide the Sample Scheduler Agent with valid user credentials. 
1 Open the Sample Scheduler configuration. 
2 Go to the Maintenance tab. 
3 Select Update OpenLab Services Credentials and enter user name and 

password. 
4 On the additional AIC, make sure that the Sample Scheduler Agent service is set 

to start automatically. 

Uninstall/Update Sample Scheduler for OpenLab 

If you want to uninstall Sample Scheduler from one computer, with either Sample 
Scheduler agent or Sample Scheduler LIMS agent installed, you must stop the 
corresponding services (Agilent Sample Scheduler agent /Agilent Sample Scheduler 
LIMS agent) prior to the uninstallation. Sample Scheduler client and Sample 
Scheduler configuration must also be closed. 

If services are not stopped prior to the uninstallation, the list of agents will not be 
updated properly into the Sample Scheduler database, and the agents will still be 
listed in the Sample Scheduler configuration, Deployment table (in stopped state). 

Connect to Another Server 

If you change the server in your OpenLab system, you will also have to update the 
OpenLab Services Credentials in Sample scheduler. For details, refer to the Sample 
Scheduler online help (search for Update OpenLab Services Credentials). 

Check up the SQL Server connectivity in case of doubt. 
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Change Authentication Mode 

If you change the authentication mode in the Control Panel, you must also manually 
update the Sample Scheduler service credentials on each Sample Scheduler 
computer that was set up with that provider. 
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Back up the Sample Scheduler database 

The Sample Scheduler database contains only a few entries that are persisted for a 
longer time. A risk-based analysis should be done to decide if, when, and how often 
a backup of the Sample Scheduler database is required. 

If you only need to back up the configuration of Sample Scheduler after it is 
considered final: It may be enough to either print out the configuration from the 
Sample Scheduler configuration application, or export the data directly from the 
relevant database tables via SQL Server Management Studio. 

If you need to back up data concerning the analyses: Decide how frequently the 
database should be backed up and how much data would be acceptable to lose in a 
worst-case scenario. 

Consider the following for the database backup strategy: 
 Check (either manual or automatic) which analyses have already been 

performed (for example, the backup still has analyses in Waiting state while the 
runs have already been carried out successfully) in order to avoid duplicate 
runs and re-analyses during a database restore. 

 Decide on how often a backup should be done  
 Make sure that the backup location is protected against possible disk failures 
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Recovery models 

Microsoft SQL server supports several recovery models. These models affect what 
the backup contains, and how the database can be restored from a backup. An 
administrator needs to decide which recovery model should be used when coming 
up with a backup strategy. 
 Simple Recovery model 

No database transaction logs get backed-up. You can only restore back to the 
point in time when the backup was finished, no further back. The database 
cannot be reverted to a state before errors occurred (such as user mistakes or 
applications mistakes).  

 Full Recovery model 

The database and the transaction logs are backed-up. You can restore back to 
any point in time. 

 Bulk Recover model 

The database and the transaction logs are backed-up, however, bulk 
transactions in the transaction log are compressed. As Sample Scheduler does 
not use bulk transactions, this recovery model should not be used with Sample 
Scheduler. 

Set up the recovery model settings on the database first, before backing up using 
that recovery model. 

For a detailed comparison, refer to the Microsoft documentation: 
https://docs.microsoft.com/en-us/sql/relational-databases/backup-
restore/recovery-models-sql-server 
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Backup Procedure 

After deciding if backups should be done, establish a backup procedure.  

For detailed information on the data repository backup of the OLDR server instance, 
refer to the document Configuring OpenLab CDS with OpenLab ECM.  

Depending on the SQL server edition, different options are available: 
 SQL Express 

Microsoft SQL Express only offers manually or job triggered backups. 

For manual backups, log in to the database server with Microsoft SQL Server 
Management Studio, right-click the Sample Scheduler database, and select 
Tasks > Back Up... 

For automating the procedure, follow the Microsoft guide on 
https://support.microsoft.com/en-us/help/2019698/how-to-schedule-and-
automate-backups-of-sql-server-databases-in-sql-se 

 SQL Server Standard or Enterprise 

Backups on SQL Server Standard or Enterprise should be automated with the 
SQL Server Agent. To set this up, follow the procedures on 
https://docs.microsoft.com/en-us/sql/relational-databases/maintenance-
plans/use-the-maintenance-plan-wizard?view=sql-server-2017 

Restore in case of failure 

If a database failure occurred, proceed as follows to restore the database to the 
consistent state of the backup: 
1 If the Sample Scheduler configuration is still able to start and display the 

running agents in the Deployment tab, first stop the running Scheduler agents, 
then log in to the Microsoft SQL Server Management Studio. 

2 To disconnect all connections to the database and set them offline, execute the 
following statement in a new SQL query: 

   alter database OpenLabSchedulerDBXXX set offline with  
   rollback immediate 

3 After this has finished executing, restore a backup: 
a Right- click the database, then select Tasks > Restore > Database. 
b Select the backup you want to restore. 
c In case of a Full Recovery model setting on the database, choose the point 

in time to which the database should be restored to. 
4 After finishing the restore procedure on the database, log in to the Sample 

Scheduler configuration and restart all services in the Deployment tab. 
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Appendix A: Microsoft SQL 
Server Configuration 

Find below some information regarding the configuration of SQL Server. According 
to the version of SQL Server you are installing, the interfaces could be different, but 
you should access the same options. 

Configure SQL Protocol for Remote Access 

1 Start the application Microsoft SQL Server 20xx/Configuration Tools/SQL Server 
Configuration Manager. 

  
   Figure 21 SQL Server Configuration Manager 

2 Select the SQL Server Instance in the left panel 
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3 Edit the TCP/IP properties 
4 Enable the protocol TCP/IP 

  
   Figure 22 Enable TCP/IP 

5 Select the second tab IP Addresses 

  
   Figure 23 IP Addresses 
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6 Activate and enable the IP address allocated to the current machine over the 
network. 

7 Close the dialog. 

 

Another option is to make the SQL Server instance listening to a static port. This 
TCP port must be defined with the help of your network IT people. Also, you may 
have to allow this static port in the Firewall’s exclusions. 

Setting a static port can be done by disabling all TCP dynamic Ports options in the 
scrolling list. Then, you must define the static TCP Port in the IP All section. 

 

 
  Figure 24 TCP Port 

 
1 Select SQL Server Services in the left pane. 
2 In the right pane, select the following services:  

 SQL Server (INSTANCE NAME),  
 SQL Server Browser (if fixed port is not set). 

  



Appendix A: Microsoft SQL Server Configuration 

Sample Scheduler for OpenLab 125 
  

3 Set Automatic start mode. 

  
   Figure 25 Automatic Start Mode 

4 Restart both services. 

  
   Figure 26 Configuration Manager 

5 Close the application. 
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Switch SQL Server Authentication Mode 

1 Start SQL Server Management Studio. 

  
   Figure 27 SQL Server Management Studio 

2 Connect to the SQL Server instance with valid Authentication mode and 
credentials. 

  
   Figure 28 Connect to Server 
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3 Select the instance and click Properties. 

  
   Figure 29 Properties 

4 Select Security and change the Server Authentication mode. 

  
   Figure 30 Security 

5 Close the dialog. 

After switching to Server Authentication Mode, you must restart the SQL Server 
service SQL Server (INSTANCE NAME). 
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CAUTION If configuring the Windows Authentication mode, ensure that all the Windows 
users that will log on Sample Scheduler computers have the privilege to access 
the OpenLab Scheduler database (for example, sysadmin). Contact your 
database administrators to know which privilege you must set to be consistent 
with your company policy rules. 

 

 
  Figure 31 Server Roles 

Edit or Add System Administrator 

If you have selected SQL Server and Windows Authentication Mode, you can add a 
system administrator user or edit the default one (sa). 
1 Start SQL Server Management Studio. 
2 Edit the System Administrator password (sa): 
3 On the left pane, select Security/Logins/sa. 
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4 Click Properties. 

  
   Figure 32 Properties 

5 Change the password. 

  
   Figure 33 Change password 
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6 Ensure the user is Enabled. 

  
   Figure 34 Enable user 

7 Close the dialog. 

The SQL Service (INSTANCE NAME) service does not need to be restarted. 
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Setting Up SQL Server Accounts other than ‘sa’ 

CAUTION If you want to use Windows Authentication Mode to let the Sample Scheduler 
components log in to the SQL Server database, you must change the user who 
runs the Sample Scheduler agent and Sample Scheduler LIMS agent. Change 
users via the Windows Services application. The services need to run with an 
account that has the required privileges on the database, as described below. 

 

If the installation was done by an administrator using an SQL Server account with 
the privilege to create a database, it might be required to make Sample Scheduler 
use an SQL Server account with less privileges. This depends on your company 
policies. 

The following instructions are guidelines on how to setup accounts that should be 
used by Sample Scheduler. There are other possibilities setting up and organizing 
the privileges on the SQL Server side, however this document is not the SQL Server 
documentation. This document lists which privileges are required to get Sample 
Scheduler working, and it shows how to achieve that goal in a simple way. 

Create the User/Group that should be used by Sample Scheduler 

1 To add a new database user for use with Sample Scheduler, connect to the 
database instance with Microsoft SQL Management Studio. You need to do this 
with an account that has the privilege to create new users and assign 
permissions to them. 

2 On the instance level, right-click Security>Logins, then select New Login.  
  



Appendix A: Microsoft SQL Server Configuration 

132  Sample Scheduler for OpenLab  
 

3 If the new user should be a Windows user or group, you can search for it. For 
finding groups click Object Types… and select Groups to add Groups to the 
Object Types that should be searched for. 

  
   Figure 35 Object types 

4 If you want to use SQL Server authentication with the new account, you need to 
specify passwords. Make sure that you either clear User must change 
password at next login, or that you change the password manually before 
using the account with Sample Scheduler. 

5 After you are done specifying the login details, switch to the Server Roles tab. 
6 Select Server Roles. Only public should be selected, the other ones are not 

needed during operation of Sample Scheduler. 
7 Switch to the User Mapping tab. Select OpenLab Scheduler database 

(OpenLabSchedulerDB+<version number>). 
8 The user column will be set to the new user you created. You can leave that as 

it is, no default Schema has to be selected. 
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9 In the list of Database roles, select public, db_datareader and db_datawriter. 

  
   Figure 36 Database roles 
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Give Execute Permission to the New User/Group 

1 Select the OpenLab Scheduler database (OpenLabSchedulerDB+ <version 
number>) in the Object Browser (InstanceName > Databases > 
OpenLabSchedulerDBxxx > Properties). 

2 Go to the Permissions tab and execute a search for the user/group that was 
just created. Then select that user/group under the User or roles section. 

3 On the Explicit tab select the Grant check box for Execute: 

  
   Figure 37 Grant execute permission 
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Give User the Right to Execute Stored Procedure 

1 Go to InstanceName > Databases > OpenLabSchedulerDBxxx> 
Programmability > Stored Procedures and right-click 
dbo.GetUpdatedExperiments. Search again for the user that should be set up.  

2 Then select Grant in the line Execute for that user.  
3 Click OK. 

After doing this step you need to reconfigure Sample Scheduler to use the new 
account. Do that using the Database reconfiguration tool as described under 
“Reconfigure Sample Scheduler Database” on page 112. 

Also make sure that, if you use Windows authentication, you set up the Sample 
Scheduler services to run under a services account that has been added to the 
database. 

 
  Figure 38 Set up Sample Scheduler services 
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Configure Firewall for SQL Server 

The Firewall can block the communication between the SQL Server and the client 
application. 

If the firewall is activated and you are not allowed to stop it, you have to add the 
following exclusions: 
 Inbound rule, protocol TCP, port 1433, 
 Inbound rule, protocol UDP, port 1434, 
 Inbound rule, all ports for the application. 

For SQL server 2012, use %ProgramFiles% (x86)\Microsoft SQL 
Server\MSSQL11.SQLEXPRESS\MSSQL\Binn\sqlservr.exe. 
The path can differ depending on the SQL Server version. 

See Microsoft documentation: http://msdn.microsoft.com/en-
us/library/cc646023.aspx 

 

If you still have some issues, check the firewall on the client side. 
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Testing Sample Scheduler Database Connectivity 

Microsoft SQL Server has been installed successfully, providing an “instance” in 
which the Sample Scheduler database exists or is going to be created. But it might 
be useful to check that the instance (and the databases inside) can be accessed 
from any machine that should have a role in the Sample Scheduler deployment. 
Furthermore, it could be useful to check that connectivity is easy, at any time, for 
example in case of network configuration changes.  

The following steps below provide a persistent way to check the implementation by 
defining an ODBC source. You only have to gather the following information, maybe 
with the help of your network IT people. Some of this information will remain 
unused depending on your network architecture: 
 The name of the SQL Server machine. 
 The IP address of that machine if the name cannot be resolved automatically 

by the DNS (The SQL Server machine could be unknown to the DNS which 
manages the current machine). 

 The name of the SQL Server instance in which the Sample Scheduler database 
is created. 

 Did you define a static TCP/IP port that the SQL Server instance must listen to, 
or did you keep it as dynamically determined? (This refers to the section 
“Configure SQL Protocol for Remote Access” on page 122, TCP/IP properties in 
the SQL Server installation above). 

Check Database Connectivity 

1 Launch Microsoft Control Panel from the start menu. 
2 Select Administrative Tools, then launch Data Sources (ODBC). 
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3 Select the User DSN tab and start creating a brand-new data source by clicking 
Add. 

  
   Figure 39  User DSN 

4 Select the driver for which you want to set up a data source. The list provided 
here probably already contains SQL Server from Microsoft Corporation since it 
is often installed with Windows. 

  
   Figure 40  Create New Data Source 
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5 Click Finish once you have selected SQL Server. 
6 Choose a name and enter any description (for example, testing Sample 

Scheduler connectivity). Then identify the SQL Server you want to connect to. 

  
   Figure 41 Choose a name 
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7 The Server field can be filled manually or with the help of the combo box. As 
you can see below, you may have several possible ways to follow. Beginning 
from the easiest one: 
 The combo box provides an option composed by the SQL Server machine 

and the SQL Server instance: 
 Go ahead; you probably do not have any problem of connectivity from that 

computer. 
 The combo box provides an option only composed by the SQL Server 

machine: 
 Select that option and append it with “\” and the name of the instance. 
 Enter the IP address of the SQL Server machine by yourself, forget the 

instance. 

   
    Figure 42  Identify SQL Server 

8 Click Next. 
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9 Select some authentication parameters according to the options you selected 
while installing Microsoft SQL Server and setting the instance. 

If a static TCP/IP port was defined so that the SQL Server instance must listen 
to it, click Client Configuration. This refers to the section “Configure SQL 
Protocol for Remote Access” on page 122, TCP/IP properties in the SQL Server 
installation above. 

Otherwise click Next. 

  
   Figure 43 Select authentication parameters 
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10 If you have to deal with the Client Configuration, then settings must be defined 
in the following way:  
 Network libraries are set to TCP/IP. 
 Server name only contains the SQL Server machine name. 
 Uncheck Dynamically determine port and enter the port number that the 

SQL Server instance is expected to listen to. 
 Click OK to go back on the authentication panel and click Next from there. 

   
    Figure 44 Client Configuration 
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11 At this stage, the process tries to connect to the SQL Server instance with all 
parameters you gave. 
In case of failure a popup message appears. The connection could not be 
established, and you may consider the following actions: 
 Check SQL Server installation (machine and instance name, authentication 

mode, credential and TCP/IP properties). 
 Check firewall settings on the SQL Server machine. 
 Replace the name of the SQL Server machine by its IP address (DNS issue). 
 Check that the SQL Server machine is really reachable over the network 

from where you are. 

It might be useful to report to the network IT people you usually contact in case 
of trouble. 

  
   Figure 45 Error message 
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12 If the connection succeeded, click Next on the following panels until you can 
use the Finish button that really creates the ODBC source. 

Then the last panel appears and summarizes the settings of the ODBC source. 
You can now Test Data Source. 

From now you are able to test your data source at any time without having to 
define again all parameters seen above (except possible passwords). 

  
   Figure 46 Test Data Source 
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14 Appendix B: Sample Scheduler for OpenLab 
Lab Balance Bridge 

Compatibility 

The Bridge is supported with the following software revisions: 
 Sample Scheduler 2.7 
 LabX Version 11 
 LabX Version 12. 

Any other product versions have not been qualified by the software vendors. 

Requirements 

The Sample Scheduler Balance Bridge has the following hardware and software 
requirements: 
 Needs to be installed on a Windows machine 
 Operating system: 

 Windows 10 
 Windows 11 
 Windows Server 2019 

 RAM: 500 MB for use of the Bridge 
 The host needs to be able to reach both application servers, the LabX 

Integration Service (running by default on port 51155), and the Sample 
Scheduler Webserver (running by default on port 443). 

 The Sample Scheduler Bridge can only be used in combination with LabX 
Balance and the LabX System Integration Option. 

 Needs to be installed on the server after the Sample Scheduler. 

After installation, the files can be verified using the Software Verification Tool. 
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Configuration 

After installation, configure the service for the environment. 
1 In the installation folder, right-click LabXSampleSchedulerBridge.exe. 
2 Select Run as administrator. 

A command line window opens. 
3 Update the settings as required. 

Once you finish the guided update process, the changes are saved 
automatically. The credentials are encrypted when saving. 

 
 

NOTE To configure the logging and poll interval for LabX setting, you need to directly edit 
the appsettings.json file. 

 
 

The following tables list the parameters that need to be adapted to match the 
environment. 

Table 14 Balance Bridge LabX integration settings 

Description JSONPath Comment 

LabX Service user 
username 

LabX.ServiceConfig.ApiUser Needs to have the following LabX privileges: 
Results.View 

LabX Service user 
password 

LabX.ServiceConfig.ApiUserSecret  

LabX Service 
Service URL 

LabX.ServiceConfig.ServiceURL http://localhost:51155/LabX/ 
BasicSystemIntegrationService 

 
 

Table 15 Agilent Sample Scheduler for OpenLab integration settings 

Description JSONPath Comment 

OpenLab user name SampleScheduler.ApiUser Needs to have the following OpenLab 
Sample Scheduler privileges: 
Is a user (Sample Scheduler), 
Add analysis (Sample Scheduler) 

OpenLab user 
password 

SampleScheduler.ApiUserSecret  

OpenLab user domain SampleScheduler.Domain Optional, if OpenLab is configured to use 
Domain credentials 

Sample Scheduler 
Webserver host 

SampleScheduler.ServerHost  
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Logging Configuration: 

The third section should be left as is. It configures the logging location and behavior 
and can be used to diagnose configuration failures. Two parameters can be 
adapted, if needed to diagnose issues. 

Table 16 Logging configuration 

Description JSONPath Comment 

Logfile path Serilog.WriteTo.Args.path Path to the logfile 

Loglevel Serilog.MinimumLevel Available levels: Debug, Warning 

Optional OpenLab Configuration 

To have additional parameters submitted from LabX to OpenLab CDS, the following 
Sample Custom Parameters can be set up in projects via the OpenLab Control 
Panel that will be used for samples coming from the LabX software. 

Table 17 OpenLab configuration 

Sample Custom 
Parameter Name 

Sample Custom 
Parameter Type 

Description 

BatchID Text Contains LabX BatchID 

LabX meta data Text Contains: 
LabX User, LabX TaskID and LabX Status, in a key value 
format: 
<key_name1>:<key_value1>|<key_name2>:<key_value2> 
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LabX Task Result Mapping 

The connection tool monitors LabX for tasks that have been completed and 
transfers the relevant data of that task over to Sample Scheduler according to the 
mapping definitions defined below. 

Only tasks that have normally completed will be picked up by the tool. Tasks that 
were stopped are ignored and their data is not transferred to Sample Scheduler. 

Mapped Method Function Names 

The mapping between results in the LabX tasks and the parameters in Sample 
Scheduler is based on the method function names in the LabX method. The 
following table lists the correlations between LabX results and Sample Scheduler 
parameters. 

Global Parameters 

Following parameters are expected once per task (outside sample scope). 

Table 18 Global parameters 

Method Function Name Transferred Data Comments 

BatchID Text See optional OpenLab configuration 
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LabX Sample Parameters 

Following parameters are expected once per sample (inside sample scope). 

Table 19 LabX sample parameters 

Method Function 
Name 

Transferred 
Data 

Sample Scheduler 
Parameter 

Comments 

Sample.ID2 Text Barcode The value is taken from SampleID2 
instead of a Method Function 

SampleType Text SampleType Defaults to Undefined; accepted 
Text values are: 
Sample, Calibration Standard, Blank, 
Doubleblank, QC Check, Sys Suit, 
Spike. Spaces and upper and lower 
case are ignored 

ConcentrationLevel Number Level Defaults to 1 

SolventName Text -  

LiquidVolume Number & Unit Description Mandatory* 

Density Number & Unit -  

CompoundName Text Compound Name Mandatory* 

CompoundAmount Number & Unit Description Mandatory* 
Only available for sample type: 
Cal. Std., QC Check 

SampleAmount Number Sample amount, 
Description 

Only available for sample type: 
Sample 

FinalConcentration Number & Unit Description Mandatory* 

* Mandatory: LabX sample is ignored if value is not present. If no valid sample detected, 
the whole task is ignored. 

Weighing Results Transmitted to OpenLab Sample Scheduler 

The LabX Bridge submits values to different parameters depending on the sample 
type submitted by LabX. In case of calibration samples, the concentration as 
calculated by LabX is mapped to the CompoundAmount. In case of samples of the 
type Sample, the weighed-in amount is mapped to the SampleAmount. 
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Appendix C: Troubleshooting 

In case of any error, you can refer to the logs generated by the application to 
understand the reason and perform by yourself a corrective action. Logs are 
generated in the %ProgramData%\Agilent\Sample Scheduler for OpenLab\Logs 
folder. 

For details on how the logs are produced, refer to the “Activity Logs” chapter on 
page 111. 
 Command blocked in the LIMS Commands folder or trashed: 

Agilent.Scheduler.Lims.Agent.log. 
 Acquisition not managed properly: Agilent.Scheduler.Agent.log or 

Agilent.Scheduler.Acquisition.Agent.InstrumentName.log 
 Display issue in Scheduler interface: Agilent.Scheduler.Client.log 

 

NOTE Some problems are induced by a database connection issue. Keep it in mind while 
investigating and do not hesitate to check up the database connectivity. How to 
check SQL Server connectivity is described in Appendix A. 

 

Some errors can be solved by following one of the simple procedures described 
below. 
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Core Engine Service does not Start 

Without the Database Management Service, the following Sample Scheduler 
services are unable to start: 
 Agilent Sample Scheduler Agent 
 Agilent Sample Scheduler LIMS Agent 
 Agilent Sample Scheduler Orchestrator 
 Agilent Sample Scheduler Webserver 

Both Sample Scheduler Services do not Start 

When the service (Agilent Sample Scheduler agent or Agilent Sample Scheduler 
LIMS agent) is stopped and cannot be started, with an error listed in the logs, check 
the following points: 
 The Enterprise path is properly configured in the OpenLab system, and is 

reachable (that is: No network communication issue). If it is not the case, 
contact the CDS administrator to solve the issue. 

 The user used to connect to the OpenLab system has no privilege to use any of 
the instruments configured in Sample Scheduler configuration / Instrument 
Management: 

Ensure that the user configured in the Sample Scheduler 
configuration/Maintenance/Update OpenLab Services Credentials screen has 
privileges to use all instruments and all projects to be managed by the Sample 
Scheduler. 

 To start the Sample Scheduler agents, first ensure that the Sample Scheduler 
Webserver is running. 

Sample Scheduler Agent Service does not Start 

When several Scheduler agents are installed, one or more instruments must be 
assigned to each agent. If one Scheduler agent has no instrument assigned, the 
agent automatically stops. 

When Agilent Sample Scheduler Agent service stopped automatically, open the 
Sample Scheduler configuration, go to Instrument management, and check that the 
agent manages at least one instrument. 

Changing the password of the Instrument Service Account for EZChrom systems 
also causes the Sample Scheduler Agent service not to start. In this case, change 
the Log On credentials for the Agilent Sample Scheduler Agent service on every 
Sample Scheduler installation in the EZChrom system (under Services>Agilent 
Sample Scheduler Agent > Properties). 
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XML Command Management 

Command File got Stuck in the LIMS_Commands Folder 

When commands are blocked in the LIMS_Commands folder, check that the Agilent 
Sample Scheduler LIMS agent is started. If it is not the case, start it. If it 
automatically stops again, read the Agilent.Scheduler.Lims.Agent.log to 
understand the reason. 

Command File is not Archived in the Processed Folder 

Check that the processed folder defined in the Sample Scheduler configuration 
exists. If that is not the case, create it. 

Command is Rejected in the Trash Folder 

Read the Agilent.Scheduler.Lims.Agent.log stored in 
the %ProgramData%\Agilent\Sample Scheduler for OpenLab\Logs folder to know 
why the command has been trashed. This log is located on the computer where the 
LIMS agent is installed. It can be due to an invalid value, a syntax error or the 
absence of a mandatory parameter. 
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Command collected in LIMS from SQL Query 

LIMS Database not notified back 

Due to a Loss of Connection 

You may have defined SQL queries in the Sample Scheduler configuration in order 
to notify the LIMS database about a command that has been handled. If a 
momentary loss of connection occurs, the LIMS database is not notified. The 
Sample Scheduler could handle again the same command, then trash it as it 
detects an analysis with the same name already exists. 

In this case you get the following message in the LIMS agent log: 
  | Info | Notifying LIMS database for VALID command Id 3... 
  | Warn | Unable to notify LIMS database,     
  ‘System.Data.SqlClient.SqlException' occurred with message  
  'A transport-level error has occurred when sending the  
  request to the server. (Provider: TCP Provider, error: 0 -  
  An existing connection was forcibly closed by the remote  
  host.)'. 
  | Warn | Unexpected result while notifying LIMS database on 
  try 1/5 
  … 
  | Warn | Unable to notify LIMS database, connection state is 
  'Closed' 
  | Warn | Delete Analysis - no analysis found in the database 
  | Warn | Try to reopen 'Closed' LIMS database connection... 
  | Warn | Unexpected result while notifying LIMS database on 
  try 2/5 
  … 
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The SQL Query cannot Update the Command in the LIMS Database 

You may have defined SQL queries in the Sample Scheduler configuration to notify 
the LIMS database about a command has been handled. The Sample Scheduler is 
expected to update the command in the LIMS database. In some cases, the update 
could fail (note that five update attempts are performed). The following message is 
displayed in the LIMS agent log: 

 
  | Info | Notifying LIMS database for VALID command Id 1... 
  | Warn | Notification has been successfully sent to LIMS  
  database but no row was affected. 
  | Warn | Unexpected result while notifying LIMS database on 
  try 1/5 
  | Warn | Notification has been successfully sent to LIMS  
  database but no row was affected. 
  | Warn | Unexpected result while notifying LIMS database on 
  try 2/5 
  | Warn | Notification has been successfully sent to LIMS  
  database but no row was affected. 
  | Warn | Unexpected result while notifying LIMS database on 
  try 3/5 
  | Warn | Notification has been successfully sent to LIMS  
  database but no row was affected. 
  | Warn | Unexpected result while notifying LIMS database on 
  try 4/5 
  | Warn | Notification has been successfully sent to LIMS  
  database but no row was affected. 
  | Warn | Unexpected result while notifying LIMS database on 
  try 5/5 
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Analysis got Stuck During Life Cycle 

Analysis Stays in Scheduled State 

 Check that the instrument on which the analysis is launched is assigned to a 
Sample Scheduler agent in Scheduler configuration/Instrument management. If 
it is not the case, assign it to a Sample Scheduler agent, then restart the 
corresponding Scheduler agent in the Sample Scheduler 
configuration/Deployment tab. If the analysis still not starts, end the 
AcquisitionServer.exe (OpenLab CDS or EZChrom service) in the task manager, 
to release the connection with the instrument. 

 Check that the user defined in the OpenLab services credentials in the Sample 
Scheduler configuration still exists in the Control Panel and that he has the 
privilege to use the instrument and the project on which the analysis is 
launched. If it is not the case, update the credentials with a user who can 
access all relevant instruments and projects to perform analyses with Sample 
Scheduler. 

Analysis Stays in Submitted State 

Before starting an analysis, the Sample Scheduler acquisition agent checks for the 
instrument license and uses it during operation. If an analysis stays in Submitted 
state, check that an Agilent OpenLab Sample Scheduler Expansion Pack license is 
available. In the web browser, insert the following address: http://<name of the 
License Server>:8090.  

If no license is available (because the instrument is currently running), the Sample 
Scheduler acquisition agent tries to obtain a license in a loop (in a time interval of 
30 seconds). After 15 attempts the analysis turns into the Error state. 

The users defined in the Notification tab will be informed about the missing license 
(by email and/or on the Notification screen of the Sample Scheduler client). 

Analysis Blocked in the Sample Scheduler database 

When an analysis is blocked in the Sample Scheduler database, connect to the 
Scheduler client, select the analysis, and click Reset. To be able to reset the 
analysis, you need the privilege Reset analysis. The analysis will be either turned 
into Error or Waiting state (according to its state while it was stuck in the 
database). 



Appendix C: Troubleshooting 

156  Sample Scheduler for OpenLab  
 

Analysis Turns into Error/Waiting on Error 

Analysis Turns into Error after Having been Stopped from the CDS 

When an analysis running in the Sample Scheduler is stopped from the CDS, it turns 
into Error state in the Scheduler. Then the other scheduled analyses on the same 
instrument turn into Waiting on error state. The Scheduler is not informed that the 
acquisition has been stopped from the CDS; it is only informed that the acquisition 
didn’t go up to the end, which is an abnormal behavior from its point of view. 

 

CAUTION Reason of abort is not communicated to the CDS 

The CDS interprets this as abnormal behavior and puts the analysis into Error 
state. 

 Do not stop an acquisition from within the CDS that has been launched from 
the Sample Scheduler. 

 Reschedule the analyses that have been put into Waiting on error state. 

Analysis Passes from Scheduled to Error or Waiting on Error State 

When an analysis passes from Scheduled to Error or Waiting on error state, it can 
be due to an instrument error, a connection issue between Sample Scheduler and 
OpenLab CDS. You can access the reason of the error in the Sample Scheduler 
client by clicking the State cell of the Error analysis. A message extracted from 
Sample Scheduler logs and the OpenLab system logs is displayed explaining the 
reason why the analysis turned into Error. 

Client or Configuration Connection Issues 

If you get the User is not authenticated message when connecting either to the 
Sample Scheduler client or Sample Scheduler configuration, check that the user 
name still exists in the Control Panel and that the password is correct. 

If you get the User ‘Username’ is not administrator message when connecting to 
Sample Scheduler configuration, check that the user has the Is an administrator 
(Sample Scheduler) privilege in the Control Panel under Administration. 
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Analyses are not Displayed in the Sample Scheduler Client 

The user connected to the Sample Scheduler client can only see the analyses 
launched on the instruments/projects he has access to. 

If the user access privileges have been modified in the Control Panel (allow the user 
to use an instrument and/or project) while a Sample Scheduler client session is still 
open, the changes are not considered. The user cannot see the analysis associated 
with the new instrument/project in the Sample Scheduler client. The OpenLab user 
instruments/projects access privileges are loaded only at the Sample Scheduler 
client opening. To load the new instruments/projects access privileges, close and 
reopen the Sample Scheduler client. The analyses will be visible. 

Loss of Connection 

A loss of connection can be caused by database, network related or instance 
specific errors. 

When getting the message box Agilent Sample Scheduler Client (or Configuration) 
has stopped working, it could mean that you have lost the connection with the 
Sample Scheduler database. The reason can be that the connection mode and /or 
the credentials have been modified. Please read the 
Agilent.OpenLab.Scheduler.Client, or Agilent.OpenLab.Scheduler.Configuration 
logs to have more information. If analyses were running, they will be turned into the 
Error state. In the corresponding Scheduler agent log you will get the message 
Impossible to update agent instance Computer name: ComputerName, agent Id: 
scheduler agent… 

For more information about changing these parameters on the SQL Server, refer to 
the sections of “Switch SQL Server Authentication Mode” on page 126 and “Edit or 
Add System Administrator” on page 128. 

Critical Error when Saving Configuration 

When getting the following critical error on saving configuration: Configuration 
value could not be modified in database, and no connection is established to the 
database (Not connecting message in the status bar), check that the connection 
mode and the credentials have not been modified for Sample Scheduler database. 

For SQL Server, refer to “Switch SQL Server Authentication Mode” on page 126 and 
“Edit or Add System Administrator” on page 128. 
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Impossible to Start Sample Scheduler Services 

When you cannot start either the Sample Scheduler LIMS agent service or the 
Sample Scheduler agent service, and you get the Invalid OpenLab Authentication 
Ticket message in the corresponding log file: 
1 Check if the ticket is correct: 

a Open the Sample Scheduler configuration Maintenance/ Update OpenLab 
Services Credentials, define the credentials and click Save. 

b Start again the Sample Scheduler agent service or Sample Scheduler LIMS 
agent service. 

c If it still does not start, and OpenLab is configured in Windows domain 
authentication mode, perform step 2. 

2 Check on all computers where either a Sample Scheduler agent or a Sample 
Scheduler LIMS agent is installed that the Shared Services are defined by their 
IP or as: ComputerName.DNSdomain (for example, 
MyComputerName.mydomain.com). If it is not the case, modify them. 
Open Shared Services Maintenance > Server settings > Add server. Define the 
correct server, and set this server as default. 

Scalable System Shows Multiple Main Instances 

In some instances of scalable environments, the Deployment screen shows 
multiple instances of the following Sample Scheduler services: 
 Scheduler LIMS Agent 
 Scheduler Webserver 

This can happen in the following circumstance: 

Load balanced system or scalable system: CM2/CM3/Index servers, if the load 
balancer is configured as the primary OLSS server on the additional servers in the 
Shared Services maintenance utility 

For proper usage of Sample Scheduler, only activate the services on the active 
OLSS server. Deactivate them on all other servers. 
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Dashboard does not Open After Reinstallation With 
new Database 

If you have already opened a Sample Scheduler session before an upgrade, data is 
cached within the browser session. This prevents login after upgrade. 

Empty the browser cache after upgrading. 
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Appendix D: Parameter Mapping to CDS 
 

 

 
Table 20 Mapping of Parameters used in Sample Scheduler for OpenLab, OpenLab CDS version 2.x, and EZChrom 

Parameter XML in Sample 
Scheduler for OpenLab, 
version 2.x 

Parameter XML in Sample 
Scheduler for OpenLab CDS, 
version A.02.x 

Parameter in 
OpenLab CDS version 2.x 

Parameter in EZChrom  
ASCII Sequence 

SampleName SampleId SampleName SampleId 

ProcessingMethodName MethodName ProcessingMethod MethodName 

AcquisitionMethodName MethodName AcquisitionMethod n/a 

InjectionSource Position Injectionsource Tower 

Description Line SampleDescription RunDescription 

Vial Vial SampleLocation Vial 

UseMethodInjectionVolume UseMethodInjectionVolume UseMethodInjectionVolume InjectionVolumeFromMethod 

InjectionVolume InjectionVolume Volume InjectionVolume 

SampleAmount SampleMass SampleAmount SampleMass 

Dilutor1 Dilutor Dilutor1 DilutionFactor1 

Dilutor2 n/a Dilutor2 DilutionFactor2 

Dilutor3 n/a Dilutor3 DilutionFactor3 

Dilutor4 n/a Dilutor4 n/a 

Dilutor5 n/a Dilutor5 n/a 

Multiplier1 Multiplier Multiplier1 MultiplicationFactor1 

Multiplier2 n/a Multiplier2 MultiplicationFactor2 

Multiplier3 n/a Multiplier3 MultiplicationFactor3 

Multiplier4 n/a Multiplier4 n/a 

Multiplier5 n/a Multiplier5 n/a 

Description Description Description RunDescription 

SampleType SampleType SampleType Runtype 

CalibrationRuntype CalibrationMode CalibrationRuntype Runtype 

Level Level CalibrationLevel CalibrationLevel 

InjectionsPerSample n/a InjPerVial InjectionsPerVial 
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Table 20 Mapping of Parameters used in Sample Scheduler for OpenLab, OpenLab CDS version 2.x, and EZChrom 

Parameter XML in Sample 
Scheduler for OpenLab, 
version 2.x 

Parameter XML in Sample 
Scheduler for OpenLab CDS, 
version A.02.x 

Parameter in 
OpenLab CDS version 2.x 

Parameter in EZChrom  
ASCII Sequence 

n/a PrintMethodReports n/a Check box in the Sequence 
Run dialog 

Datafile DataFileName n/a DataFileName 

SamplePrepMethodName n/a SamlePrepMethod PretreatmentFileName 

n/a n/a n/a FractionCollectorFileName 

n/a not supported anymore by 
current EZChrom 

n/a Action 

Target1 n/a Target1 n/a 

Target2 n/a Target2 n/a 

Target3 n/a Target3 n/a 

Target4 n/a Target4 n/a 

Target5 n/a Target5 n/a 

InternalStandardAmount1 InternalStandardAmount InternalStandardAmount1 InternalStandardAmount 

InternalStandardAmount2 n/a InternalStandardAmount2 n/a 

InternalStandardAmount3 n/a InternalStandardAmount3 n/a 

InternalStandardAmount4 n/a InternalStandardAmount4 n/a 

InternalStandardAmount5 n/a InternalStandardAmount5 n/a 

LimsID1 n/a LimsID1 n/a 

LimsID2 n/a LimsID2 n/a 

LimsID3 n/a LimsID3 n/a 

SampleCustomParameters n/a SampleCustomParameters in 
selected Project 

n/a 

 
 
  



 

 

In This Book 
 
This manual describes the following: 
 

 Sample Scheduler Requirements 

 Sample Scheduler Installation 

 Privileges 

 Upgrade 

 Migration 

 Uninstallation 

 LIMS Commands and command validity 
process 

 Activity Logs 

 Maintenance operations 
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